Contents

Chapter 1 Operational Precautions and Limitations.................................................................7
  General Safety Information......................................................................................................7
  Regulatory Compliance..........................................................................................................7
    Australia and New Zealand..................................................................................................7
    Canada...............................................................................................................................8
    Europe..............................................................................................................................8
    United States....................................................................................................................8
    International....................................................................................................................8
  Electrical Precautions........................................................................................................9
    AC Mains Supply.............................................................................................................9
    Protective Earth Conductor............................................................................................9
  Chemical Precautions.........................................................................................................10
    System Safe Fluids.........................................................................................................11
  Environmental Precautions...............................................................................................12
    Electromagnetic Fluids....................................................................................................12
    Decommissioning and Disposal.....................................................................................13
  Qualified Personnel...........................................................................................................13
  Equipment Use and Modification......................................................................................13

Chapter 2 Hazard Symbols.....................................................................................................15
  Occupational Health and Safety Symbols..........................................................................15
  Symbols, Indicators, and Labels: Packaging.......................................................................16
  Symbols, Indicators, and Labels: LC System......................................................................17
  Documentation Symbols and Conventions.........................................................................18

Chapter 3 Introduction.............................................................................................................19
  System Description...........................................................................................................19
  Channel Assignments in the Eksigent Control Software.....................................................20

Chapter 4 Set Up the System to Run an Experiment............................................................21
  Verify the Hardware Profile...............................................................................................21
  Create a Hardware Profile...............................................................................................22
  Plumb the Injection Valve.................................................................................................27
    Direct Injection Plumbing Diagram................................................................................28
    Trap-and-Elute Plumbing Diagram................................................................................29
    Post-Column Plumbing Diagram...................................................................................30
  Plumb the Valves—Step-by-Step Instructions...................................................................31
  Install the Electrode..........................................................................................................32
  (Optional) Install an In-Line Filter....................................................................................33
  (M3 MicroLC-TE Systems Only) Verify the System Configuration..................................33
  Load the Mobile Phases......................................................................................................35
Chapter 5 Perform a Direct Injection Experiment .............................................. 42
  LC Methods for the Direct Injection Experiment ........................................... 42
  Create the Gradient Method ........................................................................... 42
  Create the Direct Injection Acquisition Method ........................................... 47
  Submit the Batch ............................................................................................ 50
  Monitor the Run .............................................................................................. 50
  (M3 MicroLC-TE Systems Only) Direct Injection Using the Gradient 2 Pump .......................................................................................... 51

Chapter 6 Perform a Trap-and-Elute Experiment ........................................... 52
  LC Methods for the Trap-and-Elute Experiment ........................................... 52
  Create the Gradient Method ........................................................................... 52
  Create the LC Method to Load the Trap Column ......................................... 57
  Create the Trap-and-Elute Acquisition Method ......................................... 61
  Submit the Batch ............................................................................................ 64
  Monitor the Run .............................................................................................. 64

Chapter 7 Routine Maintenance ....................................................................... 65
  Maintenance Schedule .................................................................................. 65
  Inspect the System ......................................................................................... 65
  Dispose of Waste .......................................................................................... 66
  Clean the Surfaces ......................................................................................... 66
  Maintenance Procedures for the Pumps ....................................................... 67
    Re-initialize the Pressure Transducers ....................................................... 67
    Replace the Pump Seal Rinse ..................................................................... 68
    Purge the Mobile Phases and Flush the System ....................................... 68
    Measure the Flow Rate .............................................................................. 70
    Calibrate the Flowmeters ......................................................................... 71
  Maintenance Procedures for the Valve ......................................................... 73
    Replace the Injection Port ......................................................................... 73
    Replace the Sample Loop ......................................................................... 74
    Replace the Valve Rotor Seal ................................................................... 74
    Replace the Valve Pod .............................................................................. 77
  Maintenance Procedures for the Autosampler .......................................... 80
    Replace the Autosampler Wash Solvents ............................................... 80
    Verify the DLW Actuator .......................................................................... 80
    Test the DLW System .............................................................................. 80
    Set the Temperature of the Sample Drawers ......................................... 82
    Replace the Syringe Needle ...................................................................... 83
    Replace the Syringe Barrel ....................................................................... 85
    Replace the Syringe Plunger ................................................................... 87
    Configure the Autosampler ....................................................................... 88
    Configure the Tray Holder Position ......................................................... 88

Recommendations for Mobile Phases ........................................................... 38
Create a Custom Mobile Phase .................................................................... 38
Flush the Injection Valve ............................................................................. 39
Allow the Column Oven to Pre-Heat .......................................................... 40
Test the LC System Connections ............................................................... 40

Dispose of Waste .......................................................................................... 66
Inspect the System ......................................................................................... 65
Submit the Batch ............................................................................................ 64
Create the Acquisition Batch .........................................................................
Create the Direct Injection Acquisition Method .........................................
Submit the Batch ............................................................................................
Monitor the Run ..............................................................................................
(M3 MicroLC-TE Systems Only) Direct Injection Using the Gradient 2 Pump.
Create the Gradient Method ...........................................................................
Create the LC Method to Load the Trap Column .........................................
Create the Trap-and-Elute Acquisition Method .........................................
Submit the Batch ............................................................................................
Monitor the Run ..............................................................................................
Appendix A Theory of Operation ..........................................................................................................121

Chapter 8 Best Practices............................................................................................................................97
Guidelines for Sample Preparation .............................................................................................................97
Best Practices for Working with PEEK-lined Fused Silica Tubing ............................................................97
Flush the Electrode at the End of the Batch .................................................................................................98
Create the LC Method to Flush the Electrode ............................................................................................98
Create the Acquisition Method to Flush the Electrode ............................................................................99

Chapter 9 Troubleshooting ..........................................................................................................................101
Troubleshooting Steps .................................................................................................................................101
Troubleshooting Tables ...............................................................................................................................101
System Initialization .................................................................................................................................102
Valves .........................................................................................................................................................103
Column Oven ...........................................................................................................................................105
Autosampler .............................................................................................................................................106
Flow Control System .................................................................................................................................107
Test the Fluid Connections .........................................................................................................................111
Troubleshoot the Move to a New Computer ...............................................................................................112
Verify the COM Port Setting .......................................................................................................................112
Issues with the Hardware Profile ...............................................................................................................112
Issues with Gain and Integral Settings for the Pump ..................................................................................113

Chapter 10 Move the System .......................................................................................................................114
Disconnect the System at the Original Location .........................................................................................114
Install the System at the New Location .......................................................................................................114
Transfer System Settings to Another Computer ......................................................................................115
Back Up the SSS Settings File ...................................................................................................................118
Install the SSS Settings File .........................................................................................................................119
Prepare the System for Storage ...................................................................................................................120

Appendix A Theory of Operation ...............................................................................................................121
Microfluidic Flow Control ...........................................................................................................................121
How the MFC System Works .......................................................................................................................122
Guidelines for Micro UHPLC Methods ......................................................................................................122
Flow Rate ..................................................................................................................................................122
Electrodes and Tubing ...............................................................................................................................125
Dynamic Load and Wash ..............................................................................................................................127
The DLW Process ....................................................................................................................................129
About Partial- and Full-loop Injections ......................................................................................................130
Injection Modes .......................................................................................................................................132
About the Autosampler Method ................................................................................................................132
Steps in the Autosampler Method ............................................................................................................133
Note: Before operating the system, carefully read all of the sections of this guide.

This section contains general safety-related information and provides regulatory compliance information. It also describes potential hazards and associated warnings for the system and the precautions that should be taken to minimize the hazards.

In addition to this section, refer to Hazard Symbols on page 15 for information about the symbols and conventions used in the laboratory environment, on the system, and in this documentation. Refer to the Site Planning Guide for site requirements.

General Safety Information

To prevent personal injury or system damage, read, understand, and obey all of the safety precautions and warnings in this document and product label information. These labels are shown with internationally recognized symbols. Failure to heed these warnings could result in serious injury.

This safety information is intended to supplement federal, state, provincial, and local environmental health and safety (EHS) regulations. The information provided covers system-related safety information applicable to the operation of the LC system. It does not cover every safety procedure that should be practised. Ultimately, the user and the organization are responsible for compliance with federal, state, provincial, and local EHS regulations and for maintaining a safe laboratory environment.

Refer to the appropriate laboratory reference material and standard operating procedures.

Regulatory Compliance

This system complies with the regulations and standards listed in this section. Refer to the Declaration of Conformity included with the system and the individual system components for dated references. Applicable labels have been affixed to the system.

Australia and New Zealand

- **Electromagnetic Compatibility (EMC):** Radio Communications Act 1992 as implemented in these standards:
Operational Precautions and Limitations

- **Safety:** AS/NZ 61010-1 and IEC 61010-2-081

**Canada**
- **Electromagnetic Interference (EMI):** CAN/CSA CISPR11. This ISM device complies with Canadian ICES-001. Refer to Electromagnetic Interference on page 12.
- **Safety:** CAN/CSA C22.2 No. 61010-1 and CAN/CSA C22.2 No 61010-2-081

**Europe**
- **Electromagnetic Compatibility (EMC):** Electromagnetic Compatibility directive 2014/30/EU as implemented in these standards:
  - EN 61326-1
  - EN 55011 (Class A)
  Refer to Electromagnetic Compatibility on page 12.
- **Safety:** Low Voltage Directives 2014/35/EU as implemented in these standards:
  - EN 61010-1
- **Packaging and Packaging Waste (PPW):** Packaging and Packaging Waste Directive 94/62/EC

**United States**
- **Radio Emissions Interference Regulations:** 47 CFR 15, as implemented in FCC Part 15 (Class A)
- **Safety:** Occupational Safety and Health Regulations, 29 CFR 1910, as implemented in these standards:

**International**
- **Electromagnetic Compatibility (EMC):**
  - IEC 61326-1
  - IEC CISPR 11 (Class A)
  - IEC 61000-3-2
  - IEC 61000-3-3
  Refer to Electromagnetic Compatibility.
• **Safety:**
  - IEC 61010-1

## Electrical Precautions

**WARNING! Electrical Shock Hazard.** Do not remove the covers. Removing the covers might cause injury or malfunctioning of the system. The covers need not be removed for routine maintenance, inspection, or adjustment. Contact a SCIEX Field Service Employee (FSE) for repairs that require the covers to be removed.

For information about system electrical specifications, refer to the *Site Planning Guide*.

### AC Mains Supply

Connect the system to a compatible AC mains supply as instructed in this guide.

**WARNING! Electrical Shock Hazard.** Use only qualified personnel for the installation of all of the electrical supplies and fixtures, and make sure that all of the installations adhere to local regulations and safety standards.

**WARNING! Electrical Shock Hazard.** Make sure that the system can be disconnected from the mains supply outlet in an emergency. Do not block the mains supply outlet.

**WARNING! Electrical Shock Hazard.** Use only the power cords supplied with the system. Do not use power cords that are not properly rated for the operation of this system.

**CAUTION: Potential System Damage.** Do not unpack or connect any system components. The FSE will unpack, connect, and configure the system for the proper operating voltage.

### Protective Earth Conductor

The mains supply must include a correctly installed protective earth conductor. The protective earth conductor must be installed or checked by a qualified electrician before the system is connected.

**WARNING! Electrical Shock Hazard.** Do not intentionally interrupt the protective earth conductor. Any interruption of the protective earth conductor creates an electrical shock hazard.
Operational Precautions and Limitations

WARNING! Electrical Shock Hazard: Make sure that a protective earth conductor (grounding cable) is connected between the sample loop and an appropriate grounding point at the ion source. This supplementary grounding will reinforce the safety configuration specified by SCIEX.

WARNING! Electrical Shock Hazard. The combination of the pump and the integrated autosampler with a mass spectrometer might require additional safety measures as described by SCIEX. Refer to the mass spectrometer Safety Guide or System User Guide for instructions for safely connecting to the protective earth conductor of the mass spectrometer.

Chemical Precautions

WARNING! Radiation Hazard, Biohazard, or Toxic Chemical Hazard. Determine whether decontamination is required prior to cleaning or maintenance. The customer must decontaminate the system prior to cleaning or maintenance if radioactive materials, biological agents, or toxic chemicals have been used with the system.

WARNING! Environmental Hazard. Do not dispose of system components in municipal waste. Follow local regulations when disposing of components.

CAUTION: Potential System Damage. Do not submerge the end of the drain tubing in the waste liquid in the waste container.

CAUTION: Potential System Damage. Make sure there are no loops in the drain tubing that goes to the waste container.

- Determine which chemicals have been used in the system prior to service and regular maintenance. Refer to the Safety Data Sheets for the health and safety precautions that must be followed with chemicals.
- Work in a well-ventilated area or fume hood.
- Always wear assigned personal protective equipment, including powder-free neoprene or nitrile gloves, safety glasses, and a laboratory coat.
- Follow required electrical safe work practices.
• Avoid ignition sources when working with flammable materials, such as isopropanol, methanol, and other flammable solvents.

• Take care in the use and disposal of any chemicals. Potential risk of personal injury if proper procedures for handling and disposing of chemicals are not followed.

• Avoid skin contact with chemicals during cleaning and wash hands after use.

• Make sure that all exhaust hoses are connected properly and that all connections are functioning as designed.

• Collect all spent liquids and dispose of them as hazardous waste.

• Comply with all of the local regulations for the storage, handling, and disposal of biohazardous, toxic, or radioactive materials.

### System Safe Fluids

The following fluids can safely be used with the system.

**CAUTION: Potential System Damage. Do not use any other fluid until confirmation is received from SCIEX that it does not present a hazard. This is not an exhaustive list.**

**Organic Solvents**
- MS-grade acetonitrile; up to 100%
- MS-grade methanol; up to 100%
- Isopropanol; up to 100%
- HPLC-grade or higher water; up to 100%

**Buffers**
- Ammonium acetate; less than 1%
- Ammonium formate; less than 1%

**Acids and Bases**
- Formic acid; less than 1%
- Acetic acid; less than 1%
- Trifluoroacetic acid (TFA); less than 1%
- Heptafluorobutyric acid (HFBA); less than 1%
- Ammonia/ammonium hydroxide; less than 1%
Environmental Precautions

Use qualified personnel for the installation of electrical mains, heating, ventilation, and plumbing supplies and fixtures. Make sure that all of the installations comply with local bylaws and biohazard regulations. For information about the required environmental conditions for the system, refer to the *Site Planning Guide*.

**WARNING!** Fire Hazard. Do not operate the system in the presence of an open flame, or in the same room as equipment that could potentially emit sparks.

**WARNING!** Biohazard. For biohazardous material use, always comply with local regulations for hazard assessment, control, and handling. This system or any part is not intended to act as a biological containment.

**WARNING!** Fire Hazard. Do not use flammable sprays (such as hair sprays or insecticide sprays) near the system. They could ignite and cause a fire.

**CAUTION: Potential System Damage.** Avoid exposure to corrosive gas and excessive dust.

**CAUTION: Potential System Damage.** Take precautions to prevent the system from falling in the event of an earthquake.

Electromagnetic Environment

**Electromagnetic Compatibility**

This equipment complies with the emission and immunity requirements as described in IEC 61326-1; Electrical equipment for measurement, control and laboratory use - EMC requirements, Part 1: General requirements.

**CAUTION: Potential Wrong Result.** Do not use this device in close proximity to sources of strong electromagnetic (EMC) radiation (for example, unshielded intentional RF sources), as EMC radiation might interfere with the proper operation and cause a wrong result.

**Electromagnetic Interference**

**Class A Equipment:** Equipment which is suitable for use in all establishments other than domestic and those directly connected to a low voltage power supply network which supplies buildings used for domestic purposes. [Derived from CISPR 11:2009, 5.3] Class A equipment shall meet Class A limits.

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC (Federal Communications Commission) Compliance Rules.
These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the operator’s manual, can cause harmful interference to radio communications.

Operation of this equipment in a residential area is likely to cause harmful interference in which case you will be required to correct the interference, at your own expense. Changes or modifications not expressly approved by the manufacturer could void your authority to operate the equipment.

Decommissioning and Disposal

Before decommissioning, decontaminate the system following local regulations.

When removing the system from service, separate and recycle different materials according to national and local environmental regulations.

**Note:** SCIEX will not accept any system returns without a completed Decontamination Form. Contact an FSE to obtain a copy of the form.

Do not dispose of system components or subassemblies, including computer parts, as unsorted municipal waste.

Waste Electrical and Electronic Equipment

Follow local municipal waste ordinances for proper disposal provisions to reduce the environmental impact of WEEE (waste, electrical, and electronic equipment). To safely dispose of this equipment, contact a local Customer Service office for complimentary equipment pick-up and recycling.

Qualified Personnel

Only qualified SCIEX personnel shall install, inspect, and service the equipment. After installing the system, the Field Service Employee (FSE) uses the *Customer Familiarization Checklist* to orient the customer on system operation, cleaning, and basic maintenance.

Equipment Use and Modification

**WARNING!** Personal Injury Hazard. Contact the SCIEX representative if product installation, adjustment, or relocation is required.

**WARNING!** Electrical Shock Hazard. Do not remove the covers. Removing the covers might cause injury or malfunctioning of the system. The covers need not be removed for routine maintenance, inspection, or adjustment. Contact a SCIEX Field Service Employee (FSE) for repairs that require the covers to be removed.
Operational Precautions and Limitations

WARNING! Personal Injury Hazard. Use SCIEX-recommended parts only. Use of parts not recommended by SCIEX or use of parts for any use other than their intended purpose can place the user at risk of harm or negatively impact system performance.

Use the system indoors in a laboratory that complies with the environmental conditions recommended in the Site Planning Guide.

If the system is used in an environment or in a manner not prescribed by the manufacturer, then the protection provided by the equipment might be impaired.

Unauthorized modification or operation of the system might cause personal injury and equipment damage, and might void the warranty. Erroneous data might be generated if the system is operated either above or below the recommended environmental conditions or operated with unauthorized modifications. Contact an FSE for information on servicing the system.
Hazard Symbols

This section lists the hazard symbols and conventions used in the laboratory environment, on the system, and in the documentation.

Occupational Health and Safety Symbols

This section describes some occupational health and safety symbols found in the documentation and laboratory environment.

Table 2-1 General Hazard Symbols

<table>
<thead>
<tr>
<th>Safety Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Personal Injury Hazard</td>
</tr>
<tr>
<td></td>
<td>Lifting Hazard.</td>
</tr>
</tbody>
</table>

Table 2-2 Chemical Hazard Symbols

<table>
<thead>
<tr>
<th>Safety Symbol</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Biohazard</td>
</tr>
<tr>
<td></td>
<td>Explosion Hazard</td>
</tr>
<tr>
<td></td>
<td>Toxic Chemical Hazard</td>
</tr>
<tr>
<td></td>
<td>Fire Hazard</td>
</tr>
</tbody>
</table>
### Table 2-3 Electrical Hazard Warning Symbols

<table>
<thead>
<tr>
<th>Safety Symbol</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Symbol]</td>
<td>Electrical Shock Hazard</td>
</tr>
</tbody>
</table>

### Table 2-4 Pressurized Gas Hazard Warning Symbols

<table>
<thead>
<tr>
<th>Safety Symbol</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Symbol]</td>
<td>Pressurized Gas Hazard</td>
</tr>
</tbody>
</table>

### Table 2-5 Mechanical Hazard Symbols

<table>
<thead>
<tr>
<th>Safety Symbol</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Symbol]</td>
<td>Hot Surface Hazard</td>
</tr>
<tr>
<td>![Symbol]</td>
<td>Puncture Hazard</td>
</tr>
</tbody>
</table>

### Symbols, Indicators, and Labels: Packaging

#### Table 2-6 Labels on the Shipping Materials

<table>
<thead>
<tr>
<th>Label/Symbol</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Symbol]</td>
<td>European Conformity</td>
</tr>
<tr>
<td>![Symbol]</td>
<td>Keep upright.</td>
</tr>
</tbody>
</table>
Table 2-6 Labels on the Shipping Materials (continued)

<table>
<thead>
<tr>
<th>Label/Symbol</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>🥃</td>
<td>Fragile</td>
</tr>
<tr>
<td>🌦</td>
<td>Keep dry</td>
</tr>
</tbody>
</table>

**Symbols, Indicators, and Labels: LC System**

*Note:* If any of the labels used to identify a component become detached, contact an FSE.

<table>
<thead>
<tr>
<th>Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🚨</td>
<td>Caution</td>
</tr>
<tr>
<td>🚨</td>
<td>Do not dispose of equipment as unsorted municipal waste (WEEE).</td>
</tr>
<tr>
<td>🌫</td>
<td>Protective Earth (ground)</td>
</tr>
<tr>
<td>🌫</td>
<td>Alternating current</td>
</tr>
<tr>
<td>🌫</td>
<td>USB connection</td>
</tr>
<tr>
<td>🌫</td>
<td>Fuse</td>
</tr>
</tbody>
</table>
FCC Compliance. This device complies with Part 15 of the FCC Rules. Operation is subject to the following conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

WARNING: NO USER SERVICEABLE PARTS INSIDE. REFER SERVICING TO QUALIFIED PERSONNEL.

WARNING: Puncture Hazard: To avoid injury during operation, keep hands and loose objects away from the autosampler arm and syringe assembly.

<table>
<thead>
<tr>
<th>Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FCC Compliance</td>
<td>FCC Compliance. This device complies with Part 15 of the FCC Rules. Operation is subject to the following conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.</td>
</tr>
<tr>
<td>WARNING: NO USER SERVICEABLE PARTS INSIDE. REFER SERVICING TO QUALIFIED PERSONNEL.</td>
<td>WARNING: NO USER SERVICEABLE PARTS INSIDE. REFER SERVICING TO QUALIFIED PERSONNEL.</td>
</tr>
<tr>
<td>WARNING: Puncture Hazard: To avoid injury during operation, keep hands and loose objects away from the autosampler arm and syringe assembly.</td>
<td>WARNING: Puncture Hazard: To avoid injury during operation, keep hands and loose objects away from the autosampler arm and syringe assembly.</td>
</tr>
<tr>
<td>V</td>
<td>Volts (voltage)</td>
</tr>
<tr>
<td>A</td>
<td>Amperes (current)</td>
</tr>
<tr>
<td>VA</td>
<td>Volt Ampere (power)</td>
</tr>
</tbody>
</table>

Documentation Symbols and Conventions

The following symbols and conventions are used throughout the guide.

DANGER! Danger signifies an action which leads to severe injury or death.

WARNING! Warning signifies an action that could cause personal injury if precautions are not followed.

CAUTION: Caution signifies an operation that could cause damage to the system or corruption or loss of data if precautions are not followed.

Note: Note emphasizes significant information in a procedure or description.

Tip! Tip provides useful information that helps apply the techniques and procedures in the text for a specific need and provides shortcuts, but is not essential to the completion of a procedure.
This guide describes the basic operation and critical parameters to consider for routine and robust operation of the SCIEX M3 MicroLC systems.

**System Description**

The M3 MicroLC system can perform direct injection experiments. It includes:

- Binary gradient pumping system with one of two flow rate configurations:
  - Low flow—5 µL/min to 50 µL/min
  - High flow—20 µL/min to 200 µL/min
- 6-port stainless-steel injection valve
- Solvent rack with multiple mounting options
- Column oven
- System accessory kit, with sample loops, a column, fittings, and other supplies
- Integrated CTC Analytics PAL HTC-xt autosampler, including:
  - Three cooled sample drawers
  - Dynamic load and wash (DLW) system
- Parts to interface with a mass spectrometer:
  - Hardware for mounting the column oven on a SCIEX mass spectrometer
  - 65 µm i.d stainless steel ion source electrode
  - MS interface cable
  - For low-flow configurations, a 25 µm i.d electrode

The M3 MicroLC-TE system can perform trap-and-elute or direct injection experiments. It includes all of the above, as well as:

- A second binary gradient pump configured for 20 µL/min to 200 µL/min flow rates
- A 6-port stainless-steel auxiliary valve
- A trap column holder and trap cartridges
Channel Assignments in the Eksigent Control Software

The M3 MicroLC and M3 MicroLC-TE systems have one or two pump channels, respectively. The pumps are identified in this guide and in the software as Gradient 1 and Gradient 2.

In the software, select the channel in an active dialog or window by clicking the arrow beside the channel. The channel typically shows in the top right corner of a dialog or window. Refer to Figure 3-1.

Figure 3-1 Channel Selection Controls
Set Up the System to Run an Experiment

This chapter describes the steps to prepare the M3 MicroLC system to run an experiment using the Analyst® software. The procedures are similar for direct injection and trap-and-elute experiments with any differences noted. The procedures described in this chapter assume the system has already been properly installed and initialized.

Complete the following steps in the order in which they appear:

- Verify the Hardware Profile
- Plumb the Injection Valve
- Install the Electrode
- (M3 MicroLC-TE Systems Only) Verify the System Configuration
- Load the Mobile Phases
- Flush the Injection Valve
- Allow the Column Oven to Pre-Heat
- Test the LC System Connections

Note: The screen captures shown in this chapter are for the M3 MicroLC-TE system. For a M3 MicroLC system, the images will be slightly different.

Verify the Hardware Profile

The active hardware profile in the Analyst® software must include the autosampler and the Eksigent control software. The hardware profile is configured at installation. However, if a different computer is being used or the Analyst® software has been uninstalled, then the hardware profile might not be correct. Use these steps to verify the hardware profile.

1. Close the Eksigent control software.
2. Open the Analyst® software.
3. On the Navigation bar, under Configure, double-click Hardware Configuration.
4. In the Hardware Configuration Editor dialog, click each hardware profile to open it and locate a profile that contains a mass spectrometer, the autosampler, and the Eksigent control software.
Figure 4-1 Hardware Configuration Editor Dialog —Configured for M3 MicroLC-TE System

If an appropriate hardware profile does not exist, create one. Refer to Create a Hardware Profile on page 22.

**Note:** For a TripleTOF® system with a CDS, additional steps are required after creating the hardware profile. Refer to Modify the Calibration Method for a SCIEX TripleTOF System on page 93).

5. If the profile does not have a green check to the left, click **Activate Profile**.

   The active profile is shown with a check, the Eksigent control software launches and the Acquisition window opens. If the window does not open (indicating that the Eksigent control software did not start), then close the Analyst® software.

6. Close the Hardware Profile window.

   **Note:** Do not start the Eksigent control software manually. Instead, allow the Analyst® software to start the Eksigent control software. (When the Eksigent control software is launched independently, the LC Methods button is replaced with the **Run Manager** button.)

**Create a Hardware Profile**

The active hardware profile must include the autosampler and the Eksigent control software. Create a hardware profile if an appropriate profile does not already exist.

1. Close the Eksigent control software.
2. Open the Analyst® software.
3. On the Navigation bar, under Configure, double-click Hardware Configuration.

4. Click New Profile.

**Figure 4-2 Create New Hardware Profile Dialog**

5. Type a name in the **Profile Name** field.

6. Add the mass spectrometer to the profile.
   a. Click **Add device**.
   b. Select **Mass Spectrometer** in the **Device Type** list.
   c. Click the appropriate mass spectrometer in the list and then click **OK**.

   **Tip!** The correct instrument is usually highlighted in the list.

7. Add the autosampler to the profile and then configure it.
   a. Click **Add Device** to open the Available Devices dialog.
   b. Select **Autosampler** in the **Device Type** list, click **AutoSampler CTC PAL**, and then click **OK**.
Set Up the System to Run an Experiment

c. Click **Setup Device** to open the CTC PAL dialog.

**Figure 4-3 CTC PAL Dialog**

![CTC PAL Dialog](image)

d. Click **Configure**, select the appropriate COM port from the **Serial Port** list, and then click **OK**.

**Figure 4-4 CTC PAL Configuration Editor—Selecting the COM Port**

![CTC PAL Configuration Editor](image)
e. Type the loop volumes in the fields in the **Valve Loop Volume** section. The value in the field is logged in the data file but it does not affect the run.

f. Click **OK**.

8. Add the Eksigent control software to the profile and then configure it for the Gradient 1 pump.
   a. Click **Add Device**.
   b. Select **Software Application** in the **Device Type** list, then click **Software Application <not configured>**.
   c. Click **OK**.
   d. Click **Setup Device** to open the **Software Application Settings** dialog.

   **Note:** If nothing is listed in the **Software applications** list in the Software Application Settings dialog, the Eksigent driver for the Analyst® software is not installed. Follow the instructions in step 6 of **Transfer System Settings to Another Computer** on page 115 to install the driver (omit the step for the settings).

e. Click **Gradient 1**, and then click **OK**.

9. For an M3 MicroLC-TE system, repeat step 8 to configure the second pump (click **Gradient 2**).
10. Click **OK** to save the profile.

11. If the profile does not have a green check to the left, click **Activate Profile**.

12. Click **Close**.

   The active profile is shown with a check, the Eksigent control software launches and the Acquisition window opens.
Figure 4-6 Eksigent Control Software Acquisition Window Started from Analyst Software

Plumb the Injection Valve

The M3 MicroLC system is plumbed differently depending upon the type of experiment:

- For a direct injection experiment, refer to Direct Injection Plumbing Diagram on page 28.
- For a trap-and-elute experiment, refer to Trap-and-Elute Plumbing Diagram on page 29.

For either type of experiment, a different column, trap column, or sample loop may be installed as appropriate for the experimental conditions.

Note: Do not start the Eksigent control software manually. Instead, allow the Analyst® software to start the Eksigent control software. (When the Eksigent control software is launched independently, the LC Methods button is replaced with the Run Manager button.)
Direct Injection Plumbing Diagram

Direct injection experiments can be performed on either an M3 MicroLC or an M3 MicroLC-TE system.

Figure 4-7 Injection Valve Plumbing for Direct Injection Experiments

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Stainless-steel tubing 150 µm i.d., 1/32 inch o.d., 10 cm</td>
<td>205-00059</td>
</tr>
<tr>
<td>2</td>
<td>Gray tubing, 50 µm i.d., 1/32 inch o.d., 10 cm</td>
<td>205-00069</td>
</tr>
<tr>
<td>3</td>
<td>To ion source and mass spectrometer. Refer to Figure 4-9 on page 30.</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>HALO peptide C18 column 0.5 mm i.d. × 5 cm</td>
<td>5039577</td>
</tr>
<tr>
<td></td>
<td>Black PEEK fittings</td>
<td>200-00342</td>
</tr>
<tr>
<td>5</td>
<td>Gray tubing, 50 µm i.d., 1/32 inch o.d., 50 cm (shorter or longer as necessary)</td>
<td>205-00041</td>
</tr>
<tr>
<td>6</td>
<td>5 µL sample loop (loops with other volumes can be used)</td>
<td>5017799</td>
</tr>
<tr>
<td>7</td>
<td>Injection port</td>
<td>5052374</td>
</tr>
</tbody>
</table>

For all connections before the analytical column, use gold-colored nuts (PN 5024174) and ferrules (PN 910-00087).
**Trap-and-Elute Plumbing Diagram**

Trap-and-elute experiments can only be performed on the M3 MicroLC-TE system.

**Figure 4-8 Injection Valve Plumbing for Trap-and-Elute Experiments**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Gray tubing, 50 µm i.d., 1/32 inch o.d., 20 cm</td>
<td>205-00039</td>
</tr>
<tr>
<td>2</td>
<td>Stainless-steel tubing, 150 µm i.d., 1/32 inch o.d., 10 cm</td>
<td>205-00059</td>
</tr>
<tr>
<td>3</td>
<td>To ion source and mass spectrometer. Refer to <em>Figure 4-9 on page 30.</em></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>HALO peptide C18 column 0.5 mm i.d. x 5 cm</td>
<td>5039577</td>
</tr>
<tr>
<td></td>
<td>Black PEEK fittings</td>
<td>200-00342</td>
</tr>
<tr>
<td>5</td>
<td>Gray tubing, 50 µm i.d., 1/32 inch o.d., 50 cm (shorter or longer as necessary)</td>
<td>205-00041</td>
</tr>
<tr>
<td>6</td>
<td>Trap column (cartridge holder and ChromXP C18 cartridge, 0.5 mm i.d. x 1 cm), and two 10 cm pieces of gray tubing (item 7)</td>
<td>5027467</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5028897</td>
</tr>
<tr>
<td>7</td>
<td>Gray tubing, 50 µm i.d., 1/32 inch o.d., 10 cm</td>
<td>205-00069</td>
</tr>
<tr>
<td>8</td>
<td>50 µL stainless steel sample loop</td>
<td>5040770</td>
</tr>
<tr>
<td>9</td>
<td>Injection port</td>
<td>5052374</td>
</tr>
</tbody>
</table>

For all connections before the analytical column, use gold-colored nuts (PN 5024174) and ferrules (PN 910-00087).
Post-Column Plumbing Diagram

Plumbing details after the column vary based on the ion source electrode in use. Refer to Table 4-1 to select the appropriate electrode for the planned flow rate.

All tubing is 1/32 inch outer diameter (o.d.).

Figure 4-9 Connections—Ion Source Electrodes

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>Part Number</th>
<th>Item</th>
<th>Description</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Orange 25 µm i.d. tubing, 10 cm</td>
<td>205-00091</td>
<td>6</td>
<td>50 µm i.d. electrode (not included with system)</td>
<td>5028466</td>
</tr>
<tr>
<td>2</td>
<td>Red PEEK fitting</td>
<td>200-00330</td>
<td>7</td>
<td>Gray 50 µm i.d. tubing, 5 cm</td>
<td>205-00070</td>
</tr>
<tr>
<td>3</td>
<td>25 µm i.d. electrode (only included with low-flow systems)</td>
<td>5028467</td>
<td>8</td>
<td>Stainless steel grounding union</td>
<td>5016413</td>
</tr>
<tr>
<td>4</td>
<td>Grounding cable</td>
<td>5016435</td>
<td>9</td>
<td>65 µm i.d. electrode</td>
<td>5029342</td>
</tr>
<tr>
<td>5</td>
<td>Gray 50 µm i.d. tubing, 10 cm</td>
<td>205-00069</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Plumb the Valves—Step-by-Step Instructions

**WARNING!** Electrical Shock Hazard. Do not bypass the grounding union connection. The grounding union provides grounding between the mass spectrometer and the sample introduction device.

**WARNING!** Electrical Shock Hazard: Use a red fitting at the ion source electrode to prevent the risk of electrical shock. Do not use conductive fittings such as the high-pressure carbon-filled black fittings.

Before plumbing the valves, read Best Practices for Working with PEEK-lined Fused Silica Tubing on page 97.

Unless otherwise noted, all connections are made with gold-colored nuts and ferrules.

**Tip!** If the injection port is not installed, then install it and then configure the position of the port before plumbing the valves. Refer to Configure the Injection Port on page 90.

1. Plumb port 2 on the injection valve with 10 cm of 0.006 inch (150 µm) i.d., 1/32 inch o.d. stainless steel tubing and then put the other end in the waste drain.

2. Install the sample loop in ports 1 and 4 on the injection valve using a 3/16 inch wrench.
   - For a direct injection experiment: Use a 5 µL sample loop.
   - For a trap-and-elute experiment: Use a 50 µL sample loop.

   **Note:** Do not use the fittings included with the loop.

3. For a direct injection experiment, plumb the G1 pump outlet to port 6 on the injection valve with 10 cm of 50 µm i.d., 1/32 inch o.d. tubing.

4. For a trap-and-elute experiment, use 10 cm of 50 µm i.d., 1/32 inch o.d. tubing and plumb the pump outlets as follows:
   - G2 pump outlet to port 6 on the injection valve.
   - G1 pump outlet to port 5 on the auxiliary valve.

5. For a trap-and-elute experiment, assemble and install the trap column and then plumb the auxiliary valve.
   a. Insert a trap column cartridge into the trap column cartridge holder. There is no preferred orientation for the cartridge.
   b. Install the trap column in ports 1 and 4 on the auxiliary valve with the arrow on the cartridge holder pointing from port 4 to port 1. For each connection, use 10 cm of 50 µm i.d., 1/32 inch o.d. tubing and the nuts supplied with the trap column.
   c. Put the trap column in the trap column mount on the valve basin.
Set Up the System to Run an Experiment

d. Plumb port 2 on the auxiliary valve with 10 cm of 0.006 inch (150 µm) i.d., 1/32 inch o.d. stainless steel tubing and put the other end in the waste drain.

e. Connect port 5 on the injection valve to port 3 on the auxiliary valve with 20 cm of 50 µm i.d., 1/32 inch o.d. tubing.

6. Connect the valve to the column inlet using 50 cm of 50 µm i.d., 1/32 inch o.d. tubing, and a black PEEK fitting at the column inlet. The valve and port depend on the type of experiment:
   • For a direct injection experiment: Port 5 on the injection valve.
   • For a trap-and-elute experiment: Port 6 on the auxiliary valve.

Tip! If necessary to accommodate the laboratory layout, longer tubing can be used, but make the length of the tubing from the valve to the column as short as possible.

7. (Optional) Install an in-line filter after the column. Refer to (Optional) Install an In-Line Filter on page 33.

8. If necessary, install the electrode in the ion source probe. Refer to Install the Electrode on page 32.

9. Connect the column to the ion source electrode using a black PEEK fitting at the column outlet, a red PEEK fitting at the electrode, and the appropriate tubing for the electrode in use. Refer to Post-Column Plumbing Diagram on page 30.

   Note: For the 65 µm i.d. electrode, install two pieces of tubing connected by a union after the column.

10. Clip one end of the grounding cable to the grounding point on the ion source.

11. Clip the other end of the grounding cable as follows:
   • 25 µm and 50 µm i.d. electrodes: Clip to the grounding union on the probe.
   • 65 µm i.d. electrodes: Clip to the grounding union installed on the tubing after the column.

12. Put the column in the column oven.

13. Cut a piece of the foam block from the column oven kit and then put it on top of the column to hold the column securely against the metal surface of the oven for good thermal contact.

14. Close the column oven.

Install the Electrode

The smaller columns used in micro ultra-high performance liquid chromatography require lower flow rates and smaller electrodes than traditional liquid chromatography. Depending on the planned flow rates for the system, install the appropriate electrode in the Turbo V™ or DuoSpray™ ion source probe.
### Table 4-1 Suggested Electrode by Flow Rate

<table>
<thead>
<tr>
<th>Flow Rate (µL/min)</th>
<th>Electrode</th>
</tr>
</thead>
<tbody>
<tr>
<td>5 to 20</td>
<td>25 µm i.d.</td>
</tr>
<tr>
<td>20 to 50</td>
<td>50 µm i.d.</td>
</tr>
<tr>
<td>20 to 100</td>
<td>65 µm i.d.</td>
</tr>
</tbody>
</table>

**Note:** The upper limit for the flow rate is ultimately determined by the pressure limits of the system and the column.

1. Replace the existing spring with the one provided with the electrode.
2. Install the electrode in the Turbo V™ or DuoSpray™ probe in the same manner as the standard larger i.d. electrode.
3. Tighten the black screw cap on the probe and then adjust as necessary to extend the electrode tip 1 mm to 2 mm past the probe tip.

**Optional Install an In-Line Filter**

A post-column in-line filter can be used to help protect the mass spectrometer from impurities in the sample. The in-line filter consists of a filter housing and a capsule and can be purchased from SCIEX.

1. Install the filter cartridge in the filter housing.

   **Note:** The filter capsule has no preferred orientation, but after the first use, do not change its orientation in the filter housing.

2. Install the filter between the column and the electrode, using two 5 cm pieces of tubing. Select tubing based on flow rate:
   - Flow rates >~20 µL/min: Use 50 µm i.d tubing.
   - Flow rates <~20 µL/min: Use 25 µm i.d. tubing.
3. Connect the other end of the tubing to the electrode, using a red PEEK fitting.

**(M3 MicroLC-TE Systems Only) Verify the System Configuration**

For M3 MicroLC-TE systems, the plumbing and a setting in the Eksigent control software depend on the type of experiment. Make sure that the system is set up correctly for the type of experiment to be performed.
1. Make sure that the valve is correctly plumbed for the type of experiment to be performed.
   - Direct Injection Plumbing Diagram on page 28
   - Trap-and-Elute Plumbing Diagram on page 29

2. Set the mode in the Direct Control dialog.
   a. Select **System > Direct Control**.
   b. For a direct injection experiment, make sure that the **Trap-Elute Mode** check box is not selected.

**Figure 4-10 Direct Control Dialog—Direct Inject Mode**

![Direct Control Dialog](image)
c. For a trap-and-elute experiment, make sure that the **Trap-Elute Mode** check box is selected.

**Figure 4-11 Direct Control Dialog–Trap-and-Elute Mode**

![Direct Control Dialog](image)

- Click Close.

**Load the Mobile Phases**

This procedure assumes that the mobile phases are water and acetonitrile, with water entering the pump at the **Mobile Phase A** inlet and acetonitrile entering the pump through the **Mobile Phase B** inlet. In general, the more organic mobile phase should use the B inlet.

Refer to **Recommendations for Mobile Phases on page 38** before using different mobile phases.

1. If necessary, discard any old solvents in the mobile phase bottles, then clean the bottles with the appropriate solvents.
2. Pour new mobile phases in the bottles, then insert the mobile phase transfer tubing and filters.
3. Specify the mobile phase information in the Eksigent control software.
   a. Click **System > Mobile Phases** to open the Mobile Phases dialog.
   b. For Binary Mixture A (mobile phase A), do not make any changes.
   c. For Binary Mixture B (mobile phase B), select **Acetonitrile** in the lower list and then type **100** in the % field.
d. (Optional) Type any comments in the **Comment/Modifiers** fields.

**Figure 4-12 Mobile Phases Dialog**

![Mobile Phases Dialog](image)

**Note:** If a mobile phase that is not listed in the Mobile Phases dialog is required, either select a mobile phase with a very similar viscosity from the list or add a new one. Refer to [Create a Custom Mobile Phase](#) on page 38 for instructions.

4. Purge the pumps a minimum of 20 times.
   a. Click **More** to display additional options in the dialog.
   b. In the Purge Settings section, select the pumps to be purged and then type **20** in the purge cycles field.
   c. For an M3 MicroLC-TE system, select the **Apply to all channels** check box.
   d. Click **Purge Now**.

   The pumps begin to execute purge cycles. While the pumps are purging, make sure that the mobile phases are pulled through the mobile phase tubing to the pumps.

   e. Locate the waste tubing of the pumps being purged. The waste tubes are clear plastic tubing and emerge from the rear of the pump. After about 8 purges, the mobile phase should be purged through the waste tubing.
5. Flush the system.
   a. Disconnect the tubing coming from the G1 pump outlet.
   b. Connect one end of a length of 1/32 inch o.d. tubing to the G1 pump outlet and put the other end in the waste drain.
   c. For an M3 MicroLC-TE system, connect a second piece of tubing to the G2 pump outlet, with the free end in the waste drain.
   d. In the Flush Settings section, type 500 µL for the Total Volume and 50 µL/min for the Flush Flowrate.
   e. For an M3 MicroLC-TE system, select the Apply to all channels check box.
   f. Click Flush Now.
   g. When the flush sequence ends, click OK.

6. For each pump, reconnect the tubing between the pump outlet and the valve.
Recommendations for Mobile Phases

Mobile phases should be compatible with the following materials: 316L stainless steel, PTFE, FEP, PEEK, sapphire, glass, and fused silica. Compatible solvents include water, acetonitrile, methanol, ethanol, n-propanol, isopropanol, hexane, heptane. The pH of the mobile phases should be between pH 1 and pH 10.

In addition, the use of chlorinated solvents is not recommended.

Create a Custom Mobile Phase

Some experiments require a mobile phase other than those available in the Eksigent control software. Add a custom mobile phase in the Mobile Phases dialog. Also, create a custom mobile phase for a mixture of two solvents in one bottle.

1. Click System > Mobile Phases to open the Mobile Phases dialog.

2. For an M3 MicroLC-TE system, click the Channel buttons to select the pump that will use the new mobile phase.

3. Click More to show more options in the dialog.

4. In the Mobile Phase Change section, click Create New Fluid to open the Flowmeter Calibration dialog. (Adding a custom mobile phase includes performing a flowmeter calibration.)
5. Follow the steps in the Flowmeter Calibration dialog.
   For the calibration, select the calibration pipette based on the system configuration:
   • Low-flow configuration—100 µL
   • High-flow configuration—200 µL

Flush the Injection Valve

Flush the valve when the column is not connected to prevent introducing any contaminants from the valve to the column.

1. Disconnect the tubing from the column inlet.
2. Click **System > Direct Control** to open the Direct Control dialog.

   **Figure 4-16 Direct Control Dialog**

3. For an M3 MicroLC-TE system, click the **Channel** buttons to select **Gradient 2**.
4. Set the **Pump Direct Control** parameters and then start the pump.
   a. Select the **Conserved Flow** option.
   b. Set both **A (%)** and **B (%)** to 50.
   c. Set the **Total flowrate** to 20 µL/min.
   d. Click **Start**.
5. In the **Valve Direct Control** section, alternate clicking **Load** and **Inject**, waiting approximately 10 seconds between each click, for a total of 3 times.
Set Up the System to Run an Experiment

6. Click **Load**, then click **Stop**.
7. Reconnect the tubing to the column inlet.

**Allow the Column Oven to Pre-Heat**

The temperature of the column can be regulated, with a maximum temperature of 60 °C.

*Note:* The column oven reaches the correct temperature quickly, but the column can take as long as 30 minutes to fully equilibrate.

1. Connect the column.
2. In the Eksigent control software, click **System > Direct Control**.
3. For an M3 MicroLC-TE system, click the **Channel** buttons to select **Gradient 1**.
4. In the **Column Oven/Heater** section, type 35 the **Setpoint** field, and then click **Start**.

**Figure 4-17 Direct Control Dialog–Column Oven/Heater Section**

5. Close the compartment so the oven can reach the specified temperature.

**Test the LC System Connections**

1. Make sure that the column is connected.
2. Click **System > Direct Control** to open the Direct Control dialog.
3. Set the **Pump Direct Control** parameters.
   a. Select the **Conserved Flow (%)** option.
   b. Type 80 in the **A** field and 20 in the **B** field.

*Note:* For other experiments, set **A** and **B** to match the initial conditions in the LC method to be used in the experiment.
c. Set the **Total flowrate** based on the column diameter. For a 0.3 mm i.d. column, type **10 µL/min**. For a 0.5 mm i.d. column, type **40 µL/min**.

**Figure 4-18 Direct Control Dialog**

4. In the **Pump Direct Control** area, click **Start** to start the pump.

5. Allow the system to pump for approximately 2 minutes, inspecting the connections for any leaks, and then click **Stop**.

6. For a trap-and-elute experiment, click the **Channel** arrow buttons to select **Gradient 2** and then repeat steps 3 through 5 to test the connections for the other pump. Set the **Total flowrate** to **40 µL/min**.

7. Click **Close**.
Perform a Direct Injection Experiment

This chapter offers a brief tutorial on the use of the M3 MicroLC system to perform a direct injection experiment, using the Analyst® software. In a direct injection experiment, the sample is loaded into the injection loop and then injected directly on the analytical column.

In the example experiment that follows, a 5 µL sample loop with a full-loop injection is used. Refer to About Partial- and Full-loop Injections on page 130 for information about partial-loop and full-loop injections.

Direct injection experiments can be performed with either an M3 MicroLC or an M3 MicroLC-TE system.

**Note:** The screen captures shown in this chapter are for the M3 MicroLC-TE system. For a M3 MicroLC system, the images will be slightly different.

**Note:** These instructions assume familiarity with the Analyst software. For more information, refer to the Analyst™ Software Getting Started Guide or the System User Guide, available from the Customer Reference DVD.

LC Methods for the Direct Injection Experiment

An LC method contains the conditions used for separating the sample, including flow rate, flow mode, and mobile phase gradient. There is one LC method for the direct injection experiment.

For other LC methods, SCIEX recommends setting a minimum of 3% for mobile phase A.

Create the Gradient Method

This method is used to separate the samples using the analytical column.

1. Click LC Methods to display the LC Method Settings dialog.
2. In the Name field, type Gradient 1 Method and then click Save.
3. In the Column Information section, specify the values shown in Figure 5-1.
4. Click the **Run Conditions** tab and specify the values shown in Figure 5-2.
Perform a Direct Injection Experiment

Figure 5-2 Gradient 1 Method—Run Conditions Tab

5. Click the Gradient Table tab and set the flow mode, the gradient parameters, and the flow rate shown in Figure 5-3.

   For most experiments, select Conserved for the Flow Mode. In Conserved mode, the system calculates the flow rate for each mobile phase based on the composition and total flow rate.
6. Click the **Gradient Profile** tab to view a graphical representation of the gradient. Refer to Figure 5-4.
Perform a Direct Injection Experiment

Figure 5-4 Gradient 1 Method—Gradient Profile Tab

The last two steps in the method allow for the weaker solvent to flow through the sample loop before the next sample is injected.

7. Click **Save**, then click **OK**.
Create the Direct Injection Acquisition Method

The acquisition method specifies the parameters for each device in the hardware profile.

1. On the Navigation bar, under Acquire, double-click Build Acquisition Method.
2. In the Acquisition Method Browser pane, click Mass Spec and then specify the appropriate parameters for the experiment.
3. Click Edit Parameters to set the Source/Gas parameters.

The parameters appropriate for micro LC are different than those that are appropriate for conventional liquid chromatography. Use the values in the following figure as a starting point and then determine optimal settings as necessary.

**Figure 5-5 New Source/Gas Parameters—Suggested Initial Values**
Perform a Direct Injection Experiment

- For flow rates between 5 µL/min and 30 µL/min, these settings should be close to optimal.
- For higher flow rates, the temperature, Curtain Gas™, ion source gas 1, ion source gas 2, and the IonSpray™ voltage are typically higher.

Refer to the following table for suggested values.

Table 5-1 Source/Gas Parameters—Flow Rates from 5 µL/min to 200 µL/min

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Suggested Ranges</th>
</tr>
</thead>
<tbody>
<tr>
<td>Curtain Gas (CUR)</td>
<td>10 to 30</td>
</tr>
<tr>
<td>Ion Source Gas 1 (GS1)</td>
<td>15 to 40</td>
</tr>
<tr>
<td>Ion Source Gas 2 (GS2)</td>
<td>15 to 40</td>
</tr>
<tr>
<td>Temperature (TEM)</td>
<td>150 to 400</td>
</tr>
<tr>
<td>IonSpray Voltage (ISV) or IonSpray Voltage Floating (ISVF)</td>
<td>4500 to 5000</td>
</tr>
</tbody>
</table>

**Tip!** Higher temperatures can lead to clogged electrodes on the mass spectrometer. As appropriate, use lower temperatures.

4. Click the **Compound** tab and then set the parameters as shown for the mass spectrometer.

Table 5-2 Suggested Compound Parameters by Mass Spectrometer

<table>
<thead>
<tr>
<th>Mass Spectrometer</th>
<th>Declustering Potential (DP)</th>
<th>Collision Energy (CE)</th>
</tr>
</thead>
<tbody>
<tr>
<td>SCIEX Triple Quad™ and QTRAP® systems</td>
<td>70</td>
<td>30</td>
</tr>
<tr>
<td>TripleTOF™ systems</td>
<td>80</td>
<td>10</td>
</tr>
</tbody>
</table>

5. Click **OK** save the parameters.

6. Select the autosampler method.
   a. In the Acquisition Method window, click **CTC PAL Autosampler**.
   b. In the **Available Cycles** list, select **M3 MicroLC Direct Inject revA**.

   **Note:** The autosampler method installed with the system may have a different name than listed above. Use the most recent autosampler method supplied by SCIEX.

7. In the **Injection Volume** field, type **6** (the volume to be aspirated into the sample loop).
8. Edit parameters in the Cycle Arguments table.
   a. Type 1 in the Front Volume (µL) field.
   b. Type 1 in the Front Airgap Volume (µL) field.
   c. Type 0 in the Needle Gap for 2nd and Final Vlv Clean field.
   d. Select Wash2 for Final Wash Solvent.

   **Note:** The Rear Airgap Volume (µL) field requires a value of at least 0.01.

9. Select the LC method for the Gradient 1 pump.
   a. In the Acquisition Method Browser pane, click Gradient 1.
   b. Click ... (browse) to view the available LC methods.
   c. Click Gradient 1 Method and then click Open.

10. For an M3 MicroLC-TE system, right-click Gradient 2 and then select Use to disable the Gradient 2 pump.

![Figure 5-6 Disabling Gradient 2](image)

11. Click File > Save, and then type Direct Inject Example Method for the name of the method.

### Create the Acquisition Batch

1. On the Navigation bar, under Acquire, double-click Build Acquisition Batch.
2. Specify the required information on the Samples tab of the Batch Editor window.
3. Select the acquisition method created previously (Direct Injection Example Method).
Perform a Direct Injection Experiment

Figure 5-7 Acquisition Section—Selecting the Acquisition Method

4. In the **Sample Table**, select **VT54** for all samples in the table.

"VT54" refers to the type of autosampler tray used for vials.

Figure 5-8 Sample Table—Selecting the Plate Code

<table>
<thead>
<tr>
<th>Sample Name</th>
<th>Rack Code</th>
<th>Rack Position</th>
<th>Plate Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control001</td>
<td>1</td>
<td>1</td>
<td>MT96</td>
</tr>
<tr>
<td>Control002</td>
<td>1</td>
<td>1</td>
<td>MT96</td>
</tr>
<tr>
<td>Control003</td>
<td>1</td>
<td>1</td>
<td>MT96</td>
</tr>
<tr>
<td>10 Minutes004</td>
<td>1</td>
<td>1</td>
<td>DW96</td>
</tr>
<tr>
<td>10 Minutes005</td>
<td>1</td>
<td>1</td>
<td>VT54</td>
</tr>
<tr>
<td>10 Minutes006</td>
<td>1</td>
<td>1</td>
<td>MT96</td>
</tr>
</tbody>
</table>

Submit the Batch

1. Put the sample vials in the appropriate positions in the cooled sample drawers.
2. Click the **Submit** tab of the Batch Acquisition dialog, and then click **Submit** to add the samples to the queue.
3. Click **View > Sample Queue** to open the Queue Manager (Local) dialog.
4. Click **Acquire > Equilibrate** to equilibrate the LC system and the mass spectrometer.
5. When the equilibration is finished, click **Acquire > Start Sample** to start the batch.

Monitor the Run

1. View the LC chromatogram and spectral data in **Explore** mode in the Analyst® software.
2. View flow rate and pressure information in the Acquisition window of the Eksigent control software.
(M3 MicroLC-TE Systems Only) Direct Injection Using the Gradient 2 Pump

A low-flow M3 MicroLC-TE system can be used to perform a high-flow direct injection experiment using the Gradient 2 pump. Make the following changes:

- Plumb the G2 pump outlet to port 6 on the injection valve (instead of G1).
- Remove the MS interface cable from the I/O G1 port and connect it to the I/O G2 port.
- Create an LC method following the instructions in Create the LC Method to Load the Trap Column on page 57, but delete the "Start Gradient 1" event.
- In the Acquisition Method window, do the following:
  - In the CTC PAL Autosampler tab, select M3 MicroLC Trap Elute revA (or the most current version installed on the system). The method contains instructions required to operate the Gradient 2 pump, no matter what type of experiment is performed.
  - In the Acquisition Method Browser pane, disable the Gradient 1 pump and enable the Gradient 2 pump.
Perform a Trap-and-Elute Experiment

This chapter offers a brief tutorial on the use of the M3 MicroLC-TE system to perform a trap-and-elute experiment using the Analyst® software. In a trap-and-elute experiment, the sample is loaded into the injection loop and then transferred to the trap column by one of the pumps. Sample components are concentrated onto the trap column, while any non-retained impurities like salts are washed away. After the sample loading has been completed, the trap column is switched in-line with the analytical column, and the gradient for the analysis is started.

In the example experiment that follows, a 50 µL sample loop with a full-loop injection is used. Refer to About Partial- and Full-loop Injections on page 130 for information about partial-loop and full-loop injections.

Trap-and-elute experiments can only be performed with an M3 MicroLC-TE system.

Note: These instructions assume familiarity with the Analyst software. For more information, refer to the Analyst™ Software Getting Started Guide or the System User Guide, available from the Customer Reference DVD.

LC Methods for the Trap-and-Elute Experiment

An LC method contains the conditions used for separating the sample, including flow rate, flow mode, and mobile phase gradient. The trap-and-elute experiment has two LC methods, one for each pump.

For other LC methods, SCIEX recommends setting a minimum of 3% for mobile phase A.

Create the Gradient Method

This method is used to separate the samples using the analytical column.

1. In the Eksigent control software Acquisition window, click the arrows to select Gradient 1 in the Channel area.
2. Click LC Methods to display the LC Method Settings dialog.
3. In the Name field, type Gradient 1 Method and then click Save.
4. In the Column Information section, specify the values shown in Figure 6-1.

Perform a Trap-and-Elute Experiment
Figure 6-1 Gradient 1 Method—Summary Tab

5. Click the Run Conditions tab and then specify the values shown in Figure 6-2.
6. Click the **Gradient Table** tab and then set the flow mode, the gradient parameters, and the flow rate (Figure 6-3).

For most experiments, select **Conserved** for the **Flow Mode**. In Conserved mode, the system calculates the flow rate for each mobile phase based on the composition and total flow rate.
7. Click the Gradient Profile tab to view a graphical representation of the gradient (Figure 6-4).
The last two steps in the method allow for the aqueous solvent to flow through the sample loop before the next sample is injected.

8. Click **Save**, and then click **OK**.
Create the LC Method to Load the Trap Column

This method is used to load the sample onto the trap column.

1. In the Eksigent control software Acquisition window, click the arrows to select **Gradient 2** in the **Channel** area.
2. Click **LC Methods** to open the LC Method Settings dialog.
3. In the **Name** field, type **Trap Loading Method** and then click **Save**.
4. In the Column Information section, type the values shown in **Figure 6-5**.

**Figure 6-5 Trap Loading Method—Summary Tab**
5. Click the **Run Conditions** tab and then type the values shown in Figure 6-6.

**Figure 6-6 Trap Loading Method—Run Conditions Tab**

6. Click the **Gradient Table** tab and then set the flow mode, the gradient parameters, and the flow rate. Refer to Figure 6-7.
7. At 1.5 min, click the **Event** cell and then select **Start Gradient 1**.

This event starts the Gradient 1 pump, which switches the trap column in-line with the analytical column. The sample will be eluted from the trap column onto the analytical column.

8. Click the **Gradient Profile** tab to view a graphical representation of the gradient. Refer to **Figure 6-8**.

**Note:** If there is carryover from one sample to the next, add a step at the end of the method to wash the sample loop with the organic mobile phase.
Perform a Trap-and-Elute Experiment

Figure 6-8 Trap Loading Method—Gradient Profile Tab

9. Click **Save** and then click **OK**.
Create the Trap-and-Elute Acquisition Method

The acquisition method specifies the parameters for each device in the hardware profile.

1. On the Navigation bar, under Acquire, double-click Build Acquisition Method.
2. In the Acquisition Method Browser pane, click Mass Spec and then specify the appropriate parameters for the experiment.
3. Click Edit Parameters to set the Source/Gas parameters.

The parameters appropriate for micro LC are different than those that are appropriate for conventional liquid chromatography. Use the values in the following figure as a starting point and then determine optimal settings as necessary.

Figure 6-9 New Source/Gas Parameters—Suggested Initial Values
Perform a Trap-and-Elute Experiment

- For flow rates between 5 μL/min and 30 μL/min, these settings should be close to optimal.
- For higher flow rates, the temperature, Curtain Gas™, ion source gas 1, ion source gas 2, and the IonSpray™ voltage are typically higher.

Refer to the following table for suggested values.

Table 6-1 Source/Gas Parameters—Flow Rates from 5 μL/min to 200 μL/min

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Suggested Ranges</th>
</tr>
</thead>
<tbody>
<tr>
<td>Curtain Gas (CUR)</td>
<td>10 to 30</td>
</tr>
<tr>
<td>Ion Source Gas 1 (GS1)</td>
<td>15 to 40</td>
</tr>
<tr>
<td>Ion Source Gas 2 (GS2)</td>
<td>15 to 40</td>
</tr>
<tr>
<td>Temperature (TEM)</td>
<td>150 to 400</td>
</tr>
<tr>
<td>IonSpray Voltage (ISV) or IonSpray Voltage Floating (ISVF)</td>
<td>4500 to 5000</td>
</tr>
</tbody>
</table>

**Tip:** Higher temperatures can lead to clogged electrodes on the mass spectrometer. As appropriate, use lower temperatures.

4. Click the **Compound** tab and then set the parameters as shown for the mass spectrometer.

Table 6-2 Suggested Compound Parameters by Mass Spectrometer

<table>
<thead>
<tr>
<th>Mass Spectrometer</th>
<th>Declustering Potential (DP)</th>
<th>Collision Energy (CE)</th>
</tr>
</thead>
<tbody>
<tr>
<td>SCIEX Triple Quad™ and QTRAP® systems</td>
<td>70</td>
<td>30</td>
</tr>
<tr>
<td>TripleTOF® systems</td>
<td>80</td>
<td>10</td>
</tr>
</tbody>
</table>

5. Click **OK** save the parameters.

6. Select the autosampler method.
   a. In the Acquisition Method window, click **CTC PAL Autosampler**.
   b. In the **Available Cycles** list, select **M3 MicroLC Trap Elute revA**.

   **Note:** The autosampler method installed with the system may have a different name than listed above. Use the most recent autosampler method supplied by SCIEX.

7. In the **Injection Volume** field, type **60** (the volume to be aspirated into the sample loop).
8. Edit parameters in the Cycle Arguments table.
   a. Type 1 in the **Front Volume (µL)** field.
   b. Type 1 in the **Front Airgap Volume (µL)** field.
   c. Type 0 in the **Needle Gap for 2nd and Final Vlv Clean** field.
   d. Select **Wash2** for **Final Wash Solvent**.

   **Note:** The **Rear Airgap Volume (µL)** field requires a value of at least 0.01.

9. Select the LC method for the Gradient 1 pump.
   a. In the Acquisition Method Browser pane, click **Gradient 1**.
   b. Click ... (browse) to view the available LC methods.
   c. Click **Gradient 1 Method** and then click **Open**.

10. Select the LC method for the Gradient 2 pump.
    a. In the Acquisition Method Browser pane, click **Gradient 2**.
    b. Click ... (browse) to view the available LC methods.
    c. Click **Trap Loading Method** and then click **Open**.

11. Click **File > Save**, type **Trap-and-Elute Example Method** for the name of the method.

### Create the Acquisition Batch

1. On the Navigation bar, under **Acquire**, double-click **Build Acquisition Batch**.
2. Specify the required information on the **Samples** tab of the Batch Editor window.
3. Select the acquisition method created previously (**Trap Elute Example Method**).

**Figure 6-10 Acquisition Section—Selecting the Acquisition Method**

4. In the **Sample Table**, select **VT54** for all samples in the table.
   "VT54" refers to the type of autosampler tray used for vials.
Submit the Batch

1. Put the sample vials in the appropriate positions in the cooled sample drawers.
2. Click the Submit tab of the Batch Acquisition dialog, and then click Submit to add the samples to the queue.
3. Click View > Sample Queue to open the Queue Manager (Local) dialog.
4. Click Acquire > Equilibrate to equilibrate the LC system and the mass spectrometer.
5. When the equilibration is finished, click Acquire > Start Sample to start the batch.

Monitor the Run

1. View the LC chromatogram and spectral data in Explore mode in the Analyst® software.
2. View flow rate and pressure information in the Acquisition window of the Eksigent control software.
Routine Maintenance

This chapter describes procedures to maintain the M3 MicroLC system.

Maintenance Schedule

Perform the following procedures at the specified interval.

Table 7-1 Routine Maintenance

<table>
<thead>
<tr>
<th>Procedure</th>
<th>Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dispose of Waste</td>
<td>As needed</td>
</tr>
<tr>
<td>Replace the Autosampler Wash Solvents and Load the Mobile Phases</td>
<td>As needed</td>
</tr>
<tr>
<td>If the system is idle for more than a week, Purge the Mobile Phases and Flush the System</td>
<td>As needed</td>
</tr>
<tr>
<td>Clean the Surfaces</td>
<td>As needed</td>
</tr>
<tr>
<td>Inspect the System</td>
<td>Weekly</td>
</tr>
<tr>
<td>Re-initialize the Pressure Transducers</td>
<td>Weekly</td>
</tr>
<tr>
<td>Replace the Pump Seal Rinse</td>
<td>Quarterly</td>
</tr>
<tr>
<td>Replace the Syringe Plunger</td>
<td>Yearly</td>
</tr>
<tr>
<td>Replace the Valve Rotor Seal</td>
<td>Yearly (or as needed)</td>
</tr>
<tr>
<td>Replace the Injection Port</td>
<td>Yearly (or as needed)</td>
</tr>
</tbody>
</table>

Inspect the System

1. Inspect all solvent reservoirs for evidence of biological growth or precipitation.
   If present, replace the solvent and filter, then purge the mobile phases. Refer to Purge the Mobile Phases and Flush the System on page 68.

2. Visually inspect the system tubing and fittings.
   Look for broken fittings and dried deposits that may indicate a slow leak.
Routine Maintenance

a. As needed, tighten any loose connections.
b. If a fluidic connection is broken, replace the fitting and then flush the system. Refer to Purge the Mobile Phases and Flush the System on page 68.

Dispose of Waste

Properly dispose of the contents of any effluent waste in an appropriate chemical waste container. After disposing of the waste liquid, make sure the waste tubing has no loops and is located so that the end of the tubing will not be submerged in the waste liquid.

WARNING! Biohazard, Toxic Chemical Hazard. Follow local directives when disposing of chemicals and the remains of the prepared samples, if applicable. They might contain regulated compounds and biohazardous agents.

Clean the Surfaces

Clean the external surfaces of the system after a spill or when they become dirty.

<table>
<thead>
<tr>
<th>Required Materials</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Dry soft rags, or tissue paper</td>
</tr>
</tbody>
</table>

1. Wipe the surfaces of the system with a soft, damp, cloth.
2. Dry with a dry rag.
Re-initialize the Pressure Transducers

**CAUTION: Potential System Damage.** Open the pump outlet to make sure that there is no residual pressure on the outlet of the pump before initializing the pressure transducers. Attempting to initialize the pressure transducers while there is still residual pressure will lead to inaccurate flow rates and possibly damage to the LC system.

1. Stop the system flow.
2. Loosen the fittings in the pump outlets (on the valve panel) to release all of the residual pressure.
3. Click **System > Hardware Diagnostics**.
4. On the **Flow Calibration** tab, click **Re-Initialize Transducers**.

**Figure 7-1 Hardware Diagnostics Dialog—Flow Calibration Tab**
Routine Maintenance

5. For M3 MicroLC-TE systems, a message appears asking if the calibration should be performed for both channels. Click Yes. A warning appears that this procedure should only be performed if there is no residual pressure on the pump.

6. Make sure that the pump outlets are open, and then click OK.

   A status dialog indicates that the re-initialization is in progress.

7. When the system displays a message that the transducers are re-initialized, click OK.

8. When initialization is finished, exit the Hardware Diagnostics dialog and then return to the Acquisition window.

Replace the Pump Seal Rinse

<table>
<thead>
<tr>
<th>Required Materials</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Alcohol such as methanol, ethanol, or propanol</td>
</tr>
</tbody>
</table>

• As needed, discard the pump seal rinse (in the bottle with the green tubing) and replace it with new solvents.

   Use a 50:50 mixture of water and a common alcohol such as methanol, ethanol, or propanol and fill the bottle 2/3 full.

Purge the Mobile Phases and Flush the System

After changing the mobile phase bottles or if the system has been idle for a week or more, purge the old mobile phases from the system.

<table>
<thead>
<tr>
<th>Required Materials</th>
</tr>
</thead>
<tbody>
<tr>
<td>• 1/32 inch o.d. tubing</td>
</tr>
</tbody>
</table>

1. Make sure that the column is not connected.

2. Connect one end of a length of 1/32 inch o.d. tubing to the mobile phase outlet on the front of the pump and insert the other end into the waste.

3. In the Eksigent control software, click System > Mobile Phases, and then click More to display additional options in the dialog.

4. Purge the mobile phases.
   a. In the Purge Settings section, select the Side A or Side B (or both) check box as appropriate.
   b. (Optional) For the M3 MicroLC-TE system, select Apply to all channels to purge both channels at once.
   c. Type a minimum of 20 in the purge cycles field.
   d. Click Purge Now and wait until all purge cycles have completed.
5. Flush the system.
   a. In the **Flush Settings** section, type **200 µL** for the **Total Volume**.
   b. In the **Flush Flowrate** field, type **50 µL/min**.
   c. (Optional) For the M3 MicroLC system, select **Apply to all channels** to flush both channels at once.

   **CAUTION: Potential System Damage:** Make sure that the LC column is not connected before proceeding with this operation. Flushing the system with a column connected could over-pressure the system and create leaks.

   d. Click **Flush Now**.

**Figure 7-3 Mobile Phase Dialog—Settings for Flushing**

The system flushes 200 µL through the system.

6. Click **OK**.

7. Remove the tubing from the pump outlet and then reconnect the column.
Measure the Flow Rate

Required Materials

- Calibration kit, including 100 µL and 200 µL pipettes and 15 cm of 25 µm i.d., 1/32 inch o.d. PEEKsil tubing (PN 5018262)
- External timer

Table 7-2 Flow Rate and Calibration Specifications

<table>
<thead>
<tr>
<th>System Configuration</th>
<th>Calibration Pipette Volume</th>
<th>Calibration Flow Rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>High-flow (20 µL/min to 200 µL/min)</td>
<td>200 µL</td>
<td>100 µL/min</td>
</tr>
<tr>
<td>Low-flow (5 µL/min to 50 µL/min)</td>
<td>100 µL</td>
<td>25 µL/min</td>
</tr>
</tbody>
</table>

1. Connect the flow calibration pipette to the pump using the 25 µm i.d. PEEKsil tubing.
   a. Disconnect the tubing from the pump outlet.
   b. Connect the 25 µm i.d. PEEKsil tubing to the pump.
   c. Select the appropriate pipette for the system configuration from Table 7-2.
   d. Insert the free end of the 25 µm i.d. PEEKsil tubing in the silicon tubing on the calibration pipette.

2. Measure the time to fill the pipette with the volume specified in Table 7-2.
   a. In the Direct Control dialog, select the **Conserved Flow** option.
   b. Set the mobile phase composition to **50 A** and **50 B**.
   c. Set the **Total flowrate** as specified in Table 7-2.
   d. Click **Start**.
   The expected time varies by system configuration:
   - For the low-flow configuration, the expected time is 240 seconds. A range of 230 to 250 seconds is required.
   - For the high-flow configuration, the expected time is 120 seconds. A range of 115 to 125 seconds is required.

3. Do one of the following:
   - If the flow is within the acceptable range, the flowmeters do not need calibration. Disconnect the 25 µm i.d. PEEKsil tubing and then reconnect the original tubing between the pump and the injection valve.
• If the flow is outside of the acceptable range, Calibrate the Flowmeters on page 71.

**Calibrate the Flowmeters**

**Required Materials**

- Calibration kit, including 100 µL and 200 µL pipettes and 15 cm of 25 µm i.d., 1/32 inch o.d. PEEKsil tubing (PN 5018262) (in the ship kit box)

1. If necessary, connect the flow calibration assembly to the pump using the 25 µm i.d. tubing.
2. Click **System > Hardware Diagnostics**.
3. Click **Calibrate Flowmeter** to open the Flowmeter Calibration wizard.

![Figure 7-4 Flowmeter Calibration Wizard–Step 1](image)

4. In Step 1, verify that the mobile phases are correct and then click **Next**.
   
   If the mobile phases are not correct, click **Cancel** and then make the necessary changes in the Mobile Phases dialog. Refer to Load the Mobile Phases on page 35.

5. In the Flowmeter Calibration dialog, set the pipette size.
   
   - For the high-flow configuration and the M3 MicroLC-TE loading pump (Gradient 2)—select **200 µL/division**.
   - For the low-flow configuration—select **100 µL/division**.

![Figure 7-5 Set the Flowmeter Calibration Size–High-flow Configuration](image)

6. Click **Next** to start the flow in side A.
7. In Step 3, specify the appropriate **Volume**.
   - For the high-flow configuration and the M3 MicroLC-TE loading pump: Type **200**.
   - For the low-flow configuration: Type **100**.

   **Figure 7-6 Set the Flowmeter Calibration Volume**

8. Bring the meniscus to the black line on the pipette and then click **Start** to begin timing.

   **Figure 7-7 Calibration Pipette, Meniscus Before (Top) and At (Bottom) Black Line (Arrow Indicates Direction of Flow)**

9. When the fluid reaches the end of the pipette, click **Stop**.

10. Click **Next** and repeat the procedure to calibrate the side B flowmeter.

   **Figure 7-8 Calibrate Side B**

11. Click **Finish**.

12. Do one of the following:
   - If the calibration passed, repeat **Measure the Flow Rate on page 70** to determine whether the flow rate is within acceptable bounds.
   - If the calibration failed, inspect for leaks, make sure that the settings in the Mobile Phases dialog are correct for the solvents in use, and then purge and flush the system. Repeat the calibration. If the calibration fails again, contact SCIEX Technical Support.

13. For an M3 MicroLC-TE system, repeat the calibration for Gradient 2.
   a. Close the Flowmeter Calibration dialog.
b. In the Hardware Diagnostics dialog, click the arrows in the upper-right corner to select Gradient 2.

c. Click Calibrate Flowmeter Ch 2 to repeat the calibration.

14. Disconnect the 25 µm i.d. tubing and then connect the original tubing between the pump and the injection valve.

Maintenance Procedures for the Valve

Replace the Injection Port

<table>
<thead>
<tr>
<th>Required Materials</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Injection port (PN 5052374)</td>
</tr>
</tbody>
</table>

1. Remove the injection port from port 3 on the valve.

2. Put the port in port 3 on the injection valve and then tighten it until it is finger-tight.

**Figure 7-9 Injection Port**

3. Follow the steps in Configure the Needle Penetration into the Valve on page 91 to verify, and if necessary, set the penetration depth.
Replace the Sample Loop

The sample loop is located between ports 1 and 4 on the injection valve. Change the sample loop to inject a different sample volume or if a clog is present in the loop.

**Required Materials**

- Sample loop
- Wrench (PN 100-00567)
- 2 nuts (PN 5024174)
- 2 ferrules (PN 910-00087)

1. Remove the loop.
2. Connect the new loop to port 1 on the injection valve using the wrench and one of the ferrules.
3. Connect the other end of the loop to port 4 with the other nut and ferrule.

Replace the Valve Rotor Seal

Replace the valve rotor seal if the valve leaks.

**Required Materials**

- Long Phillips screwdriver
- Wrench (PN 100-00567)
- 9/64 inch hex key
- T20 Torx driver
- Injection valve rotor seal (PN 200-00326)

1. Close the Eksigent control software.
2. Using the switch on the rear of the system, turn off the power to the system and then unplug the mains supply cable.
3. Remove the valve from the system.
   a. Remove the sample loop and any tubing connected to the injection valve, using the wrench as needed.
   b. Remove the top valve cover by lifting it up and then sliding it out of the rear slots.
   c. Using a T20 Torx driver, remove the two screws on the front valve cover and remove it.
d. From underneath the valve, loosen the two captive screws on the valve bracket.

Figure 7-10 Valve Mounting—Captive Screws in Red

e. Carefully slide the valve down, out of the spill basin, and then disconnect the electrical cable. Make a note of where the cable connects.

4. Remove the valve stator.
   a. Use the 9/64 inch hex key to remove the three hex screws from the top of the valve stator.
   b. Lift off the stator and then set it aside.
5. Remove the rotor seal.
   a. (Optional) Lift off the black plastic alignment cylinder and then set it aside.
   b. Lift the rotor seal out of the valve.
      The rotor seal consists of a black disk in a silver case.

   **Note:** It might be possible to lift the rotor seal without removing the alignment cylinder.
6. Install the new rotor seal.
   a. Put the new rotor seal on the valve, seating it on the three pins.
   b. Replace the black plastic alignment cylinder on the valve, rotating as needed to seat it.
   c. Replace the stator and then tighten the hex screws.

7. Replace the valve.
   a. Reconnect the electrical cable.
   b. Slide the valve back into the spill basin
   c. Tighten the captive screws on the valve bracket.
   d. Replace the front valve cover and then tighten the screws.
   e. Insert the top valve cover in the rear slots.

8. As needed, plumb the injection valve.

9. Reconnect the mains supply cable and, using the switch on the rear of the system, turn on the power.

10. Press the power switch on the front of the system to turn on the system.

11. Test the seal between the valve and the injection port and, if necessary, configure the port position. Refer to Configure the Injection Port on page 90.

**Replace the Valve Pod**

<table>
<thead>
<tr>
<th>Required Materials</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Long Phillips screwdriver</td>
</tr>
<tr>
<td>• Wrench (PN 100-00567)</td>
</tr>
<tr>
<td>• T20 Torx driver</td>
</tr>
<tr>
<td>• Injection valve pod (PN 200-00452)</td>
</tr>
</tbody>
</table>

1. Close the Eksigent control software.

2. Using the switch on the rear of the system, turn off the power to the system and then unplug the mains supply cable.

3. Remove the valve from the system.
   a. Remove the sample loop and any tubing connected to the injection valve, using the wrench as needed.
Routine Maintenance

b. Remove the top valve cover by lifting it up and then sliding it out of the rear slots.

c. Using a T20 Torx driver, remove the two screws on the front valve cover and remove it.

d. From underneath the valve, loosen the two captive screws on the valve bracket.

![Figure 7-13 Valve Mounting—Captive Screws in Red]

e. Carefully slide the valve down, out of the spill basin, and then disconnect the electrical cable. Make a note of where the cable connects.

4. Remove the pod from the actuator.

a. Rotate the black ribbed retaining nut that holds the pod in the actuator to loosen it.
   
   Do not use a wrench. The retaining nut should only be tightened and loosened by hand.

b. Pull the pod from the actuator.

5. Replace the pod.

a. Insert the new pod into the actuator.
   
   The pod union will make contact with the spline in the actuator.

b. Press lightly and rotate the pod until the pod slips further into the actuator and the pin contacts the actuator.

c. Continue to rotate the pod until the pin is seated in the notch in the actuator, and then push it in (Figure 7-14).
d. Replace the retaining nut and tighten it by hand.

Figure 7-14 Valve Pod–Side View, Showing Pin in Notch

6. Replace the valve.
   a. Reconnect the electrical cable.
   b. Slide the valve back into the spill basin
   c. Tighten the captive screws on the valve bracket.
   d. Replace the front valve cover and then tighten the screws.
   e. Insert the top valve cover in the rear slots.

7. As needed, plumb the injection valve.

8. Reconnect the mains supply cable and, using the switch on the rear of the system, turn on the power.

9. Press the power switch on the front of the system to turn on the system.

10. Test the seal between the valve and the injection port and, if necessary, configure the port position. Refer to Configure the Injection Port on page 90.
Maintenance Procedures for the Autosampler

Replace the Autosampler Wash Solvents

- As needed, replenish the wash solvents in the 1 L glass bottles, using:
  - Water with 0.1% formic acid
  - Acetonitrile (or other organic solvent) with 0.1% formic acid

Verify the DLW Actuator

1. Make sure that the syringe needle is over a waste position.
2. On the keypad terminal, select **Menu (F1)**.
3. Turn the outside circular button clockwise to position the cursor over **Utilities** and press **Enter** to display the service menu.
4. Select **Wash Station > Wash 1**.
5. Press **F2** to turn on wash pump 1 and open the valve.
6. Press **Enter** and verify the blue LED on the syringe holder is lit.
   - If liquid does not flow out of the syringe, inspect the fluidic and electronic connections. The blue LED to the right of the syringe indicates that power is supplied to the actuator.

Test the DLW System

<table>
<thead>
<tr>
<th>Required Materials</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Short beaker or other container to catch wash solvent</td>
</tr>
<tr>
<td>• 10 mL or 20 mL graduated cylinder</td>
</tr>
<tr>
<td>• External timer</td>
</tr>
</tbody>
</table>

**Note:** This test requires the use of water as the wash solvent. Organic solvents typically have lower viscosities and higher flow rates, resulting in final volumes that are different than those in 2 and 3.

1. Disconnect one of the two outlet tubes from the syringe holder assembly on the side of the Z-arm and put it into the beaker.
2. Verify that the wash solvent is delivered at the dynamic load and wash (DLW) pump outlet.
   a. On the keypad terminal, select **Menu > Utilities > Wash Station > 1 (or 2) > ActValve (F2)** to start the pump.
   b. Wait 30 seconds, then press **Deact Valve (F3) > Esc** to stop the pump.
   c. Measure the volume of the collected liquid using the graduated cylinder. The cylinder should contain at least 10 mL.
      • If it contains <10 mL, the pumps are not working or the solvent lines are restricted. Contact SCIEX Technical Support.
      • If it contains >10 mL, go to the next step.

3. Verify that the wash solvent is delivered at the needle.
   a. Connect the outlet tubing to the Z-arm.
   b. Put the beaker under the syringe needle to catch the outflow.
   c. On the keypad terminal, select **Menu > Utilities > Wash Station > 1 (or 2) > ActValve (F2)** to start the pump.
   d. Wait 30 seconds, then press **Deact Valve (F3) > Esc** to stop the pump.
Routine Maintenance

e. Measure the volume of the collected liquid using the graduated cylinder. The cylinder should contain at least 6 mL.
   • If it contains >6 mL, the DLW system is working correctly.
   • If it contains <6 mL, the flow is restricted somewhere in the flow path. Verify the following, and then turn on the pump and measure the volume delivered to the graduated cylinder again.
      • Verify that there is no crimped or pinched tubing in the flow path and make sure that the flow reaches the tan PEEK fitting at the DLW actuator.
      • Verify that the connections to the DLW holding loop are not leaking.
      • Verify that the white Teflon needle seal is correctly inserted and that the needle is installed correctly. If the needle has been previously bent and then straightened, install a new needle.

4. Reconnect the outlet tubing and then repeat the entire procedure for the other outlet tubing, starting at step 1.

5. Press Esc five times to return to the main menu.

Set the Temperature of the Sample Drawers

The temperature setting for the sample drawers is shown on the front of the instrument. Change the temperature if the default is not applicable.

1. Press P for less than two seconds.

   Figure 7-16 Sample Drawers Temperature Control

"SP1" is displayed.

2. Press the Up and Down arrows to reach the desired temperature.

3. Press P again to save the temperature.
Replace the Syringe Needle

WARNING! Puncture Hazard. Handle the needle with care. The tip of the needle is extremely sharp.

1. On the keypad terminal, select **Menu > F1 Change Syringe** to move the Z-arm to a location with better access to the needle.

2. Prepare the needle.
   a. Insert the needle into the Teflon seal.
      Sometimes the hole in the seal contains a burr (Teflon residue from the seal), shown in Figure 7-17.

   **Figure 7-17 Teflon Needle Seal—Clean (Left) and with Burr (Right)**
Routine Maintenance

b. If necessary, remove any burrs.
   Remove the seal from the needle and then use the long end of the needle to push the burr out. Refer to Figure 7-18.
   Be careful not to scratch the seal.

Figure 7-18 Cleaning the Teflon Needle Seal

3. Install the needle.
   a. With one hand, lift the bottom needle guide until it touches the upper needle guide.
   b. With the other hand, guide the tip of the new needle into both guides and then release the lower needle guide.
   c. Insert the top of the needle into the fitting and then tighten the needle collar until it is finger-tight.
4. Gently move the needle collar up and down to make sure that the tip of the needle is near the bottom of the hole in the needle guide.

   If the needle guide is above the hole at rest, then the needle will probably hit the hole when compressed, bending the needle.

5. Set the needle penetration depth. Refer to Configure the Needle Penetration into the Valve on page 91.

Replace the Syringe Barrel

<table>
<thead>
<tr>
<th>Required Materials</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Syringe barrel (PN 4460861)</td>
</tr>
<tr>
<td>• T6 Torx wrench</td>
</tr>
<tr>
<td>• Hex key</td>
</tr>
</tbody>
</table>

**WARNING! Puncture Hazard. Handle the needle with care. The tip of the needle is extremely sharp.**

1. On the keypad terminal, select Menu > F1 Chang Syr.

   The Z-arm moves to a location convenient for accessing the syringe and needle.

2. Remove the syringe barrel:
   a. Rotate the knurled nuts at the top and bottom of the syringe to loosen them.
Routine Maintenance

b. Lift the syringe up and out to remove it.

3. Prepare the new syringe barrel.
   a. Manually move the plunger to the stop position.
   b. Pull the plunger slightly backwards to release pressure from the plunger tip.
   c. Install the plunger holder and tighten the hex screw firmly.

Figure 7-20 Inserting the Plunger Holder in the Syringe Barrel

4. Replace the syringe barrel.
   a. Screw the prepared syringe barrel into the holder.
      Hold the syringe barrel at the lower metal mount while tightening the syringe
   b. Move the plunger up (plunger holder) until the thread of the screw catches the thread of the plunger bushing.
   c. Tighten the screw to fix the plunger holder.
   d. Tighten the holding screw to secure the syringe holder position.
5. Insert the syringe needle tip in the lower needle guide, then move the needle back and up to the needle holder and tighten it firmly.


   The plunger moves down until it hits the mechanical stop. This position is stored as the zero volume for the syringe. The Z-arm then returns to the home position.

7. Select Menu > Utilities > Syringe > F2 Clean Syr to flush the syringe.

**Replace the Syringe Plunger**

<table>
<thead>
<tr>
<th>Required Materials</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Syringe plunger (PN 4460827)</td>
</tr>
<tr>
<td>• Alcohol for flushing the syringe barrel</td>
</tr>
</tbody>
</table>

1. On the keypad terminal, select Menu > F1 Chang Syr.

   The Z-arm moves to a location convenient for accessing the syringe and needle.

2. Remove the plunger holder and syringe barrel.
Routine Maintenance

3. Pull out the plunger.
4. Flush the barrel with alcohol to remove debris and provide a lubricant for the plunger.
5. Carefully insert the new plunger into the syringe barrel.
6. Replace the plunger holder and syringe barrel.

Configure the Autosampler

If any of the components attached to the autosampler are moved, use the keypad terminal to adjust the X, Y, and Z positions of the injection unit.

Configure the Tray Holder Position

1. Open the top drawer.
   Make sure that the needle is not installed in the syringe and the drawer is empty. The tray calibration hole should be visible.
2. On the keypad terminal:
   a. Press Menu (F1).
   b. Turn the outside circular button clockwise to position the cursor over Setup.
   c. Press F3 and then press Enter (the center button) in quick succession.
      This displays the service menu.
   d. Using the outside circular button to scroll, select Objects > Tray Holders > CStack1. Press Enter after each selection.
3. Select Clear Position (F2) and then select Z.
4. Select Check Position (F1) to move to the preset X and Y positions
5. Adjust the X, Y, and Z positions until the needle guide is accurately placed in the tray calibration hole.
   Make sure that the bottom of the needle guide is flush with the bottom surface of the tray.
6. Select Check Position (F1) to verify the needle guide position.
7. Press ESC twice to return to the Objects menu.
8. Close the drawer.

Configure the Wash Station Position

1. On the keypad terminal, navigate to Menu > Setup.
2. Press F3 then Enter.
3. Select **Objects > Wash Stations** and then press **Enter**.
4. Select **Wash1** and then press **Enter**.
5. Select **Clear Position (F2)** and then select **Z**.
6. Select **Check Position (F1)** to move to the preset position.
7. Adjust the X, Y, and Z positions until the needle guide is seated in the Wash1 port on the wash station.

**Figure 7-22 Wash Station Ports**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Wash 1 port</td>
</tr>
<tr>
<td>2</td>
<td>Waste port</td>
</tr>
<tr>
<td>3</td>
<td>Wash 2 port</td>
</tr>
</tbody>
</table>

8. Press **Enter**.
9. Select **Check Position (F1)** to verify the position.
10. Press **Esc** twice.
11. Repeat the entire procedure for Wash2.

**Configure the Injector Waste Position**

1. On the keypad terminal, navigate to **Menu > Setup**.
2. Press **F3** then **Enter**.
3. Select **Objects > Injectors** and then press **Enter**.
4. Select **Waste** and then press **Enter**.
5. Select **Clear Position (F2)** and then select **Z**.
6. Select **Check Position (F1)** to move to the preset position.

7. Adjust the X, Y, and Z positions until the needle guide is seated in the Waste port on the wash station.

**Figure 7-23 Wash Station Ports**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Wash 1 port</td>
</tr>
<tr>
<td>2</td>
<td>Waste port</td>
</tr>
<tr>
<td>3</td>
<td>Wash 2 port</td>
</tr>
</tbody>
</table>

8. Press **Enter**.

9. Select **Check Position (F1)** to verify the position.

10. Press **Esc** twice.

**Configure the Injection Port**

1. Set the position of the needle guide over the injection port.
   a. On the keypad terminal, navigate to **Menu > Setup**.
   b. Press **F3** then press **Enter**.
   c. Select **Objects > Injectors** and then press **Enter**.
   d. Select **LC VLV1** and then press **Enter**.
   e. Adjust the X, Y, and Z positions until the needle is centered over the injection port.
   f. Press **Enter**.

2. Select **Check Position (F1)** to verify the position.

3. Press **Esc** five times to return to the main menu.
Configure the Needle Penetration into the Valve

1. If the system has been previously configured with the same type of injection port that is currently installed, verify the needle penetration depth. If not, go to step 2).
   a. On the keypad terminal, navigate to Menu > Setup.
   b. Press F3 then press Enter.
   c. Select Objects > Injectors and then press Enter.
   d. Select LC VLV1.
   e. Select Needle Pentr and then press Enter.
   The needle penetration depth is correct if the bottom of the spring plate is aligned with the bottom of the syringe holder assembly, as shown in the far right of Figure 7-24.

   ![Figure 7-24 Adjusting Needle Penetration](image)

   If the depth is not correct, continue with the following steps.

2. Clear the Z position.

3. Set the needle penetration depth.
   a. Select Check Position (F1) to move to the preset position.
   b. Slowly rotate the outer knob to adjust the needle penetration depth.
      The needle moves stepwise.
c. When the needle tip enters the valve needle guide, slow down the Z movement. Move down stepwise until
the bottom of the spring plate is aligned with the bottom of the syringe holder assembly, as shown in the
far right of Figure 7-24.
Always watch the needle during this step.

**CAUTION: Potential System Damage: Do not select Needle Pentr and then press Enter. This might bend the needle.**

d. Press **F3 Movto Zero**.

4. Repeat step 1 to verify that the depth is correct.
5. Press **Esc** five times to return to the main menu.

**Additional Autosampler Configuration Procedures**

The following procedures may be required for particular situations.

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer uses tray other than VT54.</td>
<td>Set the Autosampler Tray Type on page 92</td>
</tr>
<tr>
<td>Vials are deeper or more shallow than default height.</td>
<td>Adjust the Needle Penetration Depth into the Sample Vial on page 92</td>
</tr>
</tbody>
</table>

**Set the Autosampler Tray Type**

The default tray type is VT54. To use a different tray type, use this procedure to change the tray type.

1. On the keypad terminal, select **Menu > Utilities > Tray > 1 > Tray Station**.
2. Scroll to the tray of interest and press **Select** to set the tray type.
3. Press **Esc**.
4. Repeat for tray positions 2 through 6.

**Adjust the Needle Penetration Depth into the Sample Vial**

If the vial septa or vial cap changes from when the autosampler was first configured, or if vial inserts are being used, the depth at which the needle penetrates the vial might need to be changed.

**Note:** Changing the needle penetration depth will change the penetration depth for all trays of the selected type.

1. Put a vial in position 001 in Tray 1 in the top sample drawer and close the drawer.
2. Set the needle penetration depth.
a. On the keypad terminal, select Menu > Utilities > Tray > 1 > F3 to move to vial 001.
b. Select OK > Needle Penetr.
   The needle is inserted into the vial to the currently set depth.
c. Hold the lower needle guide up and then pick up the vial or tray to see how far the needle is from the
   bottom.
d. Scroll to set the needle depth and press Select to set it.
   If the needle stops before it reaches the required depth, follow the instructions in step 3 to increase the
   range that the needle penetrates.

3. If necessary, increase the needle penetration range.
a. On the keypad terminal, select Menu > Setup.
b. Press F3 and then press Enter.
c. Select Setup > Objects > Tray Types > VT54 > Max Needle Penetr > Select. (If a different
   tray type is in use, select it instead of “VT54”).
d. Scroll to adjust the value and then press Select to set it.
e. Repeat step 2 to set the depth.

Modify the Calibration Method for a SCIEX TripleTOF® System

For a TripleTOF® system with a calibrant delivery system (CDS), the calibration method template must be modified
so that the pump will continue to flow during the calibration run on the mass spectrometer. Without this
modification, the signal stability on the mass spectrometer will be poor. This modification is initially performed
by the SCIEX FSE during the installation of the system.

The calibration method template might need to be modified if:
• The Analyst® TF software has been reinstalled or a different computer is connected to the system.
• The column or other system plumbing will not support a 40 μL/min flow rate.
• The initial mobile phase composition for the run is very different from the example experiment.
• The flow rate of the CDS is greater than 500 μL/min.

Create the LC Method for the Calibration Method Template

This method will run during the calibration run.
CAUTION: Potential System Damage: For experimental conditions other than those used in the System Integration Test, set the flow rate and the mobile phase composition as appropriate in the LC method. If the flow rate is too high, the column might be damaged.

1. Click LC Methods.
2. In the Name field, type a name for the method, and then click Save.
3. On the Run Conditions tab, set the parameters as shown in Figure 7-25.

![Figure 7-25 LC Method Settings Dialog—Run Conditions Tab](image)

4. On the Gradient Profile tab, set the profile as shown in Figure 7-26.
   a. In the % field, type the value for mobile phase B at the beginning of the run.
   b. Type the appropriate value for the current column and plumbing configuration in the Total flowrate field.
   c. If the flow rate for the CDS is > 500 µL/min, then calculate the duration for the LC method as follows:
      \[ \text{Duration} = \frac{1000}{\text{CDS flow rate}} \]
   d. Type the calculated duration in the \( t = \text{min} \) field.
5. Click **Save**, and then click **OK**.

**Update the Calibration Method Template**

Add the LC device and the LC method to the calibration method template.

1. Back up the AutoCalPos.dam file in a safe location.
   
   By default, the file is found in D:\Analyst Data\Projects\API Instrument\Instrument Optimization\methods.

2. Add the LC device to the AutoCalPos method in the Analyst® TF software.
   
   a. Activate the hardware profile that includes the M3 MicroLC system.
   
   b. In Windows Explorer, navigate to the location of the AutoCalPos.dam file.
   
   By default, the file is found in D:\Analyst Data\Projects\API Instrument\Instrument Optimization\methods.

   c. Double-click the AutoCalPos.dam file to open it in the **Acquisition Method Browser Editor**.

   d. Right-click **Acquisition Method** and then select **Add/remove device**.
e. In the Add/remove device methods dialog, select Gradient 1 and, for an M3 MicroLC-TE system, Gradient 2, and then click OK.

Figure 7-27 Add/remove device methods Dialog—M3 MicroLC-TE System

3. Select the LC method for the Gradient 1 pump.
   a. In the Acquisition Method Browser pane, click Gradient 1.
   b. Click ... (browse) to view the available LC methods.
   c. Click the name of the method created previously and then click Open.
4. For an M3 MicroLC-TE system, repeat the previous step to select the LC method for the Gradient 2 pump.
5. Save the calibration method with the same name (AutoCalPos) in the original location.
This chapter contains best practices for using the M3 MicroLC systems.

**Guidelines for Sample Preparation**

Sample preparation methods commonly used for conventional HPLC are suitable for micro LC, but the flow path can clog if samples contain too much particulate matter.

For best results, follow these guidelines:

- Use HPLC- or MS-grade solvents at all times.
- Avoid the use of non-volatile salts and buffers such as CHAPS, phosphate, TRIS, HEPES, and perchlorates. These additives will foul the ion source and mass spectrometer orifice.
- Avoid overloading the column, and the trap column, if present, with sample.
  - For 0.3 mm and 0.5 mm i.d. columns: Use <12 μg of material
  - For 1 mm i.d. columns: Use <50 μg of material
- If needed, centrifuge all samples at 10 000 RPM for 5 min to remove dust and particulates from the sample solution. Use the supernatant as the sample.
- Add a guard column (before the analytical column) to help protect the analytical column from impurities in the sample. Guard columns can be purchased from SCIEX.

**Best Practices for Working with PEEK-lined Fused Silica Tubing**

- Never cut PEEK-lined fused silica tubing. Cutting PEEK-lined fused silica tubing results in small particles of cut glass entering the flow path, leading to plugged tubing, valves, and electrodes.
- For all connections, seat the tubing at the bottom of the fitting.
Best Practices

- When connecting PEEK-lined fused silica tubing:
  1. Connect the tubing on the end farther from the mass spectrometer first.
  2. Turn on the pump and allow liquid to flow through the tubing to flush out any particulate matter.
  3. Allow flow for approximately 30 seconds before making the next connection.

- Do not over-tighten connections to PEEK-lined fused silica tubing. Over-tightening can damage tubing and lead to plugged tubing. Instead, tighten fittings until they are finger-tight, turn on the pump, and then inspect the fitting for the presence of solvent. If there is a leak, tighten the fitting about 1/16 turn at a time until there are no more leaks.

Flush the Electrode at the End of the Batch

The smaller diameter electrodes used for micro HPLC can clog. To reduce the chances of this occurring, add a sample at the end of the acquisition batch to flush the electrode.

1. Create an LC method for flushing the electrode. Refer to Create the LC Method to Flush the Electrode on page 98.
2. Create an acquisition method that includes the LC method to flush the electrode. Refer to Create the Acquisition Method to Flush the Electrode on page 99.
3. Load a vial containing a 50:50 mixture of Mobile Phase A and Mobile Phase B in the cooled sample drawer.
4. Add the sample to the batch, assigning the acquisition method.

Create the LC Method to Flush the Electrode

This method is used to flush the ion source electrode after the samples have been run.

1. Click LC Methods to display the LC Method Settings dialog.
2. In the Name field, type a name for the method, such as "Electrode Flush" and then click Save.
3. Click the Run Conditions tab and select Standard in the Sample Injection area. Refer to Figure 8-1.

Figure 8-1 Run Conditions Tab—Sample Injection Area

![Sample Injection options](image)
4. Click the Gradient Table tab and then set the flow mode, the gradient parameters, and the flow rate. Refer to Figure 8-2.

**Figure 8-2 Electrode Flush Method—Gradient Table Tab**

![Gradient Table Tab](image)

5. Click **Save**, and then click **OK**.

**Create the Acquisition Method to Flush the Electrode**

This method is used at the end of the batch to flush the electrode.

1. Select the acquisition method used for the other samples in the run.
2. Click **File > Save As** and then type **Electrode Flush Method** for the name of the method.
3. Edit the mass spec parameters.
   a. In the Acquisition Method window, click **Mass Spec**.
b. Click **Edit Parameters** to set the **Source/Gas** parameters shown in **Table 8-1**.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Curtain Gas (CUR)</td>
<td>30</td>
</tr>
<tr>
<td>Ion Source Gas 1 (GS1)</td>
<td>10</td>
</tr>
<tr>
<td>Ion Source Gas 2 (GS2)</td>
<td>10</td>
</tr>
<tr>
<td>Temperature (TEM)</td>
<td>75</td>
</tr>
</tbody>
</table>

c. Click **OK** to save the parameters.

4. Select the LC method.
   a. In the Acquisition Method window, click **Gradient 1**.
   b. Click **... (browse)** to view the available LC methods.
   c. Click **Electrode Flush** and then click **Open**.

5. Click **File > Save**.
Troubleshooting Steps

1. Step back and look at the overall system. Is something obvious causing the problem?
   For example, is the instrument unplugged or improperly connected?

2. Compare the current system operation with the way the system operated before the problem started. Identify conditions such as pressures, power settings, or flow rates that are different from when the system was operating normally.
   For example, if the output pressure is usually 2500 psi for a certain method, is the system pressure currently in the same range, or drastically higher or lower?

3. In the order listed below, identify any symptoms which vary from normal system operation:
   a. System power on and initialization (initialization fails)
   b. System diagnostics such as flow stability
   c. Flow rate in each channel (high, low, erratic)
   d. Output pressure (high, low, erratic)

4. For each symptom, refer to Troubleshooting Tables on page 101 and then perform the appropriate corrective actions.
   If this process does not correct the problem, contact SCIEX Technical Support.

Troubleshooting Tables

- System Initialization on page 102
- Valves on page 103
- Column Oven on page 105
- Autosampler on page 106
- Flow Control System on page 107
### System Initialization

#### Table 9-1 System Initialization

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power button on front of system is not lit</td>
<td>Mains supply cable not connected</td>
<td>Make sure the cable is connected to the system and plugged into the electrical outlet.</td>
</tr>
<tr>
<td></td>
<td>Power button on rear of system in the &quot;Off&quot; position</td>
<td>Press the power button on the rear of the system.</td>
</tr>
<tr>
<td></td>
<td>Power button on front of system in the &quot;Off&quot; position</td>
<td>Press the power button on the front of the system.</td>
</tr>
<tr>
<td></td>
<td>No power at outlet</td>
<td>Repair the electrical outlet.</td>
</tr>
<tr>
<td></td>
<td>Light failed but system response OK</td>
<td>Contact SCIEX Technical Support.</td>
</tr>
<tr>
<td>No Instrument Detected dialog is shown or &quot;Not connected&quot; message in Acquisition window</td>
<td>Communication error between computer and LC system</td>
<td>Make sure that the instrument USB cable is securely connected to the computer USB port. Reboot the computer and cycle the power on the instrument.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Make sure that the COM port is set correctly in the Eksigent control software. Refer to Verify the COM Port Setting on page 112.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Contact SCIEX Technical Support.</td>
</tr>
<tr>
<td>Loud hissing sound is coming from the instrument</td>
<td>Air leaking from the air inlet fitting</td>
<td>Make sure that the air tubing is properly connected to the gas fitting.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Tighten the air inlet gas fitting.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Contact SCIEX Technical Support.</td>
</tr>
</tbody>
</table>
## Valves

### Table 9-2 Valves

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Injection valve does not switch positions</td>
<td>Valve not configured in Eksigent control software</td>
<td>In the Eksigent control software, click <strong>System &gt; Instrument Configuration</strong> to open the Instrument Configuration dialog. Click the <strong>System</strong> tab and then select <strong>Eksigent Internal</strong> in the <strong>Injection Valve</strong> list.</td>
</tr>
<tr>
<td></td>
<td>Valve not connected to the actuator</td>
<td>Contact SCIEX Technical Support.</td>
</tr>
<tr>
<td></td>
<td>LC Method not correct</td>
<td>Review the LC method.</td>
</tr>
<tr>
<td>Auxiliary valve does not switch positions</td>
<td>Valve not configured in Eksigent control software</td>
<td>In the Eksigent control software, click <strong>System &gt; Instrument Configuration</strong> to open the Instrument Configuration dialog. Click the <strong>System</strong> tab and then select <strong>Eksigent Internal</strong> in the <strong>Injection Valve</strong> list.</td>
</tr>
<tr>
<td></td>
<td>Faulty electronics</td>
<td>Contact SCIEX Technical Support.</td>
</tr>
<tr>
<td></td>
<td>Faulty actuator</td>
<td>Contact SCIEX Technical Support.</td>
</tr>
<tr>
<td></td>
<td>LC Method not correct</td>
<td>Review the LC method.</td>
</tr>
<tr>
<td>No flow is coming out of the port</td>
<td>Incorrectly plumbed valve</td>
<td>Make sure that the plumbing configuration is correct and reconfigure if needed. Refer to Plumb the Injection Valve on page 27.</td>
</tr>
<tr>
<td></td>
<td>Plugged ports</td>
<td>Use a syringe to manually flush each port with cleaning solvent. If flushing does not clean the port, contact SCIEX Technical Support.</td>
</tr>
<tr>
<td>Fluid is leaking from the valve</td>
<td>Ferrule not properly seated in the port</td>
<td>Inspect the tubing connection and make sure that the ferrule is properly seated.</td>
</tr>
<tr>
<td></td>
<td>Scratched rotor seal</td>
<td>Replace the rotor seal. Refer to Replace the Valve Rotor Seal on page 74.</td>
</tr>
<tr>
<td>Symptom</td>
<td>Possible Cause</td>
<td>Corrective Action</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>-------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>When no column is connected, system pressure (Pc) is unusually high</td>
<td>Plugged ports</td>
<td>Use a syringe to manually flush each port with cleaning solvent. If flushing does not clean the port, contact SCIEX Technical Support.</td>
</tr>
<tr>
<td></td>
<td>Ends of tubing crushed</td>
<td>Replace the tubing and do not over-tighten fittings.</td>
</tr>
<tr>
<td>System does not initiate an injection</td>
<td>System flow unstable</td>
<td>Purge and flush the pump. Refer to Purge the Mobile Phases and Flush the System on page 68. and then equilibrate the system.</td>
</tr>
<tr>
<td></td>
<td>Flow stabilization set too low</td>
<td>In the Eksigent control software, click System &gt; Instrument Configuration to open the Instrument Configuration dialog. Click the Advanced tab and then set the flow stabilization limit &gt;100 nL/min.</td>
</tr>
<tr>
<td></td>
<td>Autosampler configured to wait for</td>
<td>In the LC Method Settings dialog, change Sample Injection to a value other than None.</td>
</tr>
<tr>
<td>injection but the Sample Injection setting in the Eksigent control</td>
<td>injection but the Sample Injection</td>
<td></td>
</tr>
<tr>
<td></td>
<td>setting in the Eksigent control</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Column oven not at specified</td>
<td>In the Direct Control dialog, lower the required temperature for the column oven. Refer to Allow the Column Oven to Pre-Heat on page 40.</td>
</tr>
<tr>
<td></td>
<td>temperature</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Monitor the column oven temperature in the upper right corner of the Acquisition window in the Eksigent control software and wait until the oven reaches the specified temperature. If the temperature is not reached within 15 minutes, the column oven might not be working. Contact SCIEX Technical Support.</td>
</tr>
</tbody>
</table>
### Table 9-2 Valves (continued)

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flow rate is inconsistent</td>
<td>Internal leakage in valve</td>
<td>Replace the rotor seal. Refer to Replace the Valve Rotor Seal on page 74. If the issue persists, contact SCIEX Technical Support.</td>
</tr>
<tr>
<td></td>
<td>Plugged ports</td>
<td>Use a syringe to manually flush each port with cleaning solvent. If flushing does not clean the port, contact SCIEX Technical Support.</td>
</tr>
<tr>
<td>Pressure drops at the beginning of each run</td>
<td>Air bubbles in sample loop</td>
<td>In the Analyst® software, edit the autosampler method to make sure that the sample loop is completely filled with sample. Either:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• In the Cycle Arguments table, set the Front Volume and Rear Volume &gt; 0.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Specify an Injection Volume greater than the volume of the sample loop.</td>
</tr>
<tr>
<td>Relative standard deviation (RSD) between peak areas for successive runs is high</td>
<td>Sample loop retains small amount of sample</td>
<td>In the LC Method Settings dialog, edit the Trap Loading Method to add a step which washes the sample loop with the organic mobile phase between injections.</td>
</tr>
<tr>
<td>For a trap-and-elute experiment, carryover from one run to the next</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Column Oven

### Table 9-3 Column Oven

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Column responds very slowly when changing temperature</td>
<td>Oven malfunction</td>
<td>Contact SCIEX Technical Support.</td>
</tr>
<tr>
<td>Temperature reads 47</td>
<td>Oven unplugged</td>
<td>Make sure that the column oven is plugged in.</td>
</tr>
</tbody>
</table>
## Troubleshooting

### Autosampler

#### Table 9-4 Autosampler

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample drawers are occasionally damp</td>
<td>Condensation in the sample drawers</td>
<td>When not in use, open the drawers 1 cm to 5 cm to allow air circulation.</td>
</tr>
<tr>
<td>Sample drawers are persistently damp</td>
<td></td>
<td>Flow clean, dry air or nitrogen through the sample drawers. Connect the gas line to the 1/8 inch fitting labeled <strong>Flush Gas</strong>, located at the lower right on the rear of the system. Allow the gas to flow at 300 mL/min to 400 mL/min.</td>
</tr>
<tr>
<td>Available Cycles list and Cycle Arguments table are empty in CTC Autosampler Basic Properties tab in the Acquisition Method Editor window</td>
<td>Communication issue between autosampler and the Analyst® software</td>
<td>If needed, save work and then deactivate the hardware profile. Close the Analyst® software and Eksigent control software. Restart the system and the Analyst® software, and then activate the hardware profile.</td>
</tr>
<tr>
<td>&quot;Autosampler not recognized&quot; message shown when activating the hardware profile in the Analyst® software</td>
<td></td>
<td>Verify that the USB cable between the computer and the instrument is securely connected.</td>
</tr>
<tr>
<td>Eksigent control software does not recognize the autosampler when Run Manager window opens</td>
<td>Communication issue between autosampler and computer</td>
<td>Software might be configured to use a different COM port than the autosampler is using. In the Run Manager window, select <strong>Devices &gt; Autosampler Device Settings</strong>. In the <strong>Comm Port</strong> list, select a different port and click <strong>OK</strong>.</td>
</tr>
</tbody>
</table>
## Troubleshooting

### Flow Control System

#### Table 9-5 Flow Control System

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>System pressure (Pc) or pump pressures (Pa &amp; Pb) show pressure but flow is off</td>
<td>Incorrect zero setting for pressure sensors</td>
<td>Reinitialize the pressure transducers. Refer to Re-initialize the Pressure Transducers on page 67.</td>
</tr>
<tr>
<td>No liquid coming out of waste line when purging</td>
<td>Air trapped in pump</td>
<td>Purge and flush the pump. Refer to Purge the Mobile Phases and Flush the System on page 68.</td>
</tr>
<tr>
<td></td>
<td>Internal filters are plugged</td>
<td>Purge the pumps and inspect the flow through the waste tubing after approximately 8 purges. If the flow is very low or intermittent, then the filter should be changed. Refer to Purge the Mobile Phases and Flush the System on page 68. Contact SCIEX Technical Support.</td>
</tr>
<tr>
<td></td>
<td>Leak in the system before the purge valve</td>
<td>Contact SCIEX Technical Support.</td>
</tr>
<tr>
<td>Pump re-strokes frequently (&quot;Pump has reached end of stroke&quot; error message appears)</td>
<td>Pump remains on long enough to prompt a re-stroke</td>
<td>For the current flow rate, calculate the time to pump approximately 600 µL. Verify that the pump re-strokes at approximately that time interval.</td>
</tr>
<tr>
<td></td>
<td>Check valve leaking</td>
<td>Contact SCIEX Technical Support.</td>
</tr>
<tr>
<td>Pump does not re-stroke at the end of a run</td>
<td>Optical sensor not working correctly</td>
<td>Contact SCIEX Technical Support.</td>
</tr>
<tr>
<td>Pump flushes quickly but does not deliver approximately 600 µL per stroke</td>
<td>Leak in instrument</td>
<td>Contact SCIEX Technical Support.</td>
</tr>
</tbody>
</table>
### Troubleshooting

#### Table 9-5 Flow Control System (continued)

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purge output drips slowly</td>
<td>Internal filters are plugged</td>
<td>Purge the pumps and inspect the flow through the waste tubing after approximately 8 purges. If the flow is very low or intermittent, then the filter should be changed. Refer to Purge the Mobile Phases and Flush the System on page 68. Contact SCIEX Technical Support.</td>
</tr>
<tr>
<td>Flow rate is 0 when with 100% power indicated. System pressure (Pc) and pump pressures (Pa and Pb) are all low.</td>
<td>No gas to system</td>
<td>Connect 100 psi clean, dry air or nitrogen to the instrument gas inlet. <strong>System not properly purged and flushed</strong></td>
</tr>
<tr>
<td>Incorrect mobile phases</td>
<td></td>
<td>Verify the settings in the Mobile Phases dialog. <strong>Pump controller out of tune</strong></td>
</tr>
<tr>
<td>System does not reach desired flow rate</td>
<td>Internal filters are plugged</td>
<td>Purge the pumps and inspect the flow through the waste tubing after approximately 8 purges. If the flow is very low or intermittent, then the filter should be changed. Refer to Purge the Mobile Phases and Flush the System on page 68. Contact SCIEX Technical Support.</td>
</tr>
<tr>
<td>Flow rate too high for system back pressure</td>
<td></td>
<td>In the Direct Control dialog, decrease the flow rate. <strong>Gas pressure too low</strong></td>
</tr>
<tr>
<td>Gas pressure too low</td>
<td></td>
<td><strong>Unable to meet required flow rate within specified tolerance</strong></td>
</tr>
</tbody>
</table>
### Table 9-5 Flow Control System (continued)

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flow rate does not initialize at start of run</td>
<td>Leak in instrument</td>
<td>Contact SCIEX Technical Support.</td>
</tr>
<tr>
<td></td>
<td>Internal filters are plugged</td>
<td>Purge the pumps and inspect the flow through the waste tubing after approximately 8 purges. If the flow is very low or intermittent, then the filter should be changed. Refer to Purge the Mobile Phases and Flush the System on page 68. Contact SCIEX Technical Support.</td>
</tr>
<tr>
<td>Flow rate is inaccurate but there are no signs of leakage</td>
<td>Incorrect mobile phases</td>
<td>Verify the settings in the Mobile Phases dialog.</td>
</tr>
<tr>
<td></td>
<td>Incorrect k-values</td>
<td>Calibrate the flowmeters. Refer to Calibrate the Flowmeters on page 71.</td>
</tr>
<tr>
<td>Flow rate does not stabilize during a run</td>
<td>Tubing or fitting partially plugged</td>
<td>Starting as far downstream as possible from the pump outlet, remove each tube or fitting, one at a time, until the pressure drops dramatically. Replace the plugged item. Refer to Test the Fluid Connections on page 111.</td>
</tr>
<tr>
<td></td>
<td>Air trapped in pump</td>
<td>Purge and flush the pump. Refer to Purge the Mobile Phases and Flush the System on page 68.</td>
</tr>
<tr>
<td></td>
<td>Incorrect mobile phases</td>
<td>Verify the settings in the Mobile Phases dialog.</td>
</tr>
<tr>
<td></td>
<td>Pump controller out of tune</td>
<td>Contact SCIEX Technical Support.</td>
</tr>
<tr>
<td></td>
<td>Column temperature not stable</td>
<td>Monitor the column oven temperature in the upper right corner of the Acquisition window in the Eksigent control software. If the temperature fluctuates more than about 2 °C, contact SCIEX Technical Support.</td>
</tr>
<tr>
<td>System pressure (Pc) is unusually low but flow rate is OK</td>
<td>Loose connection after the mixing Tee</td>
<td>Inspect all connections for leaks.</td>
</tr>
</tbody>
</table>
Table 9-5 Flow Control System (continued)

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>System pressure (Pc) is low and flow rate is OK but pump pressures (Pa and Pb) are high</td>
<td>Incorrect k-values</td>
<td>Calibrate the flowmeters. Refer to Calibrate the Flowmeters on page 71.</td>
</tr>
<tr>
<td></td>
<td>Flow module is plugged</td>
<td>Contact SCIEX Technical Support.</td>
</tr>
<tr>
<td>System pressure (Pc) is very high</td>
<td>Tubing or fitting is plugged</td>
<td>Starting as far downstream as possible from the pump outlet, remove each tube or fitting, one at a time, until the pressure drops dramatically. Replace the plugged item. Refer to Test the Fluid Connections on page 111.</td>
</tr>
<tr>
<td></td>
<td>Trap column is plugged</td>
<td>Replace the trap column and add an in-line filter between the injection valve and auxiliary valve. Refer to (Optional) Install an In-Line Filter on page 33, but install the filter between port 5 on the injection valve and port 3 on the auxiliary valve.</td>
</tr>
<tr>
<td>Flow noise is excessive</td>
<td>Air trapped in pump</td>
<td>Purge and flush the pump. Refer to Purge the Mobile Phases and Flush the System on page 68.</td>
</tr>
<tr>
<td></td>
<td>Pump controller out of tune</td>
<td>Contact SCIEX Technical Support.</td>
</tr>
<tr>
<td>Measured flow does not follow the flow profile</td>
<td>Pump controller out of tune</td>
<td>Contact SCIEX Technical Support.</td>
</tr>
<tr>
<td>Pump pressures (Pa and Pb) are maximized to &lt;12 000 psi at 100% pump power</td>
<td>Gas pressure too low</td>
<td>Verify that the gas supply has a pressure of 100 psi.</td>
</tr>
<tr>
<td></td>
<td>Incorrect zero setting for pressure sensors</td>
<td>Reinitialize the pressure transducers. Refer to Re-initialize the Pressure Transducers on page 67.</td>
</tr>
<tr>
<td></td>
<td>Incorrect gain setting for pressure</td>
<td>In the Calibration Values tab of the Hardware Diagnostics dialog, make sure that the pump pressures (in the Scale Parameter field) are approximately 2800 psi/V. If the value is not 2800, then contact SCIEX Technical Support.</td>
</tr>
</tbody>
</table>
Test the Fluid Connections

**CAUTION: Potential Operator Injury. To avoid the possibility of solvent exposure, be sure to have a vial or other container available to collect the solvent leaving the system.**

1. Disconnect all the exits in the flow path except for the tubing coming from the G1 pump.
2. In the Direct Control dialog, set the flow conditions to 40 µL/min with 80% A (water):20% B (acetonitrile) and then start the pump.
3. Calculate the approximate pressure for the items in the flow path using *Table 9-6*. (Initially, the only component is the 10 cm of 50 µm i.d., 1/32 inch o.d. tubing coming from the pump.)

<table>
<thead>
<tr>
<th>Item</th>
<th>Pressure (psi)</th>
</tr>
</thead>
<tbody>
<tr>
<td>5 µL sample loop</td>
<td>0</td>
</tr>
<tr>
<td>50 µL sample loop</td>
<td>0</td>
</tr>
<tr>
<td>25 µm i.d. electrode</td>
<td>2017</td>
</tr>
<tr>
<td>65 µm i.d. electrode</td>
<td>44</td>
</tr>
<tr>
<td>Gray PEEKsil tubing, 50 µm i.d., 1/32 inch o.d., 10 cm</td>
<td>63</td>
</tr>
<tr>
<td>Gray PEEKsil tubing, 50 µm i.d., 1/32 inch o.d., 20 cm</td>
<td>126</td>
</tr>
<tr>
<td>Orange PEEKsil tubing, 25 µm i.d., 1/32 inch o.d., 10 cm</td>
<td>1009</td>
</tr>
<tr>
<td>HALO peptide C18 column 0.5 mm i.d. × 5 cm</td>
<td>3200</td>
</tr>
<tr>
<td>Trap column</td>
<td>300</td>
</tr>
</tbody>
</table>

**Note:** The calculated pressures in Table 9-6 depend on the mobile phase composition. For mobile phases other than 80% A (water):20% B (acetonitrile), the values in Table 9-6 are not correct.

4. Compare the calculated pressure to the actual pressure (Pc) in the Acquisition window of the Eksigent control software.
   - If the pressure is close to the value, then the system is working as expected.
   - If the pressure is higher, then there may be a clog. Replace the part.
   - If the pressure is low, then there may be a leak. Tighten the connection or replace the part.
5. Stop the flow and then connect the next item in the flow path.
6. Start the flow again and then observe the pressure and compare it to the calculated value.
Troubleshooting

7. Repeat for the remaining components in the flow path, including the column and the ion source.
8. Stop the flow.

Troubleshoot the Move to a New Computer

When using a different computer than the one on which the M3 MicroLC system was originally installed, the following procedures might be helpful in resolving any issues.

Verify the COM Port Setting

1. In the Eksigent control software, click System > Instrument Configuration.
2. Click the System tab and make sure that the COM port is set to Auto Detect.
3. Click OK.

Issues with the Hardware Profile

Sometimes the hardware profile in the Analyst® software does not activate due to an issue with the autosampler.
1. On the existing computer, locate the most recent version of the pal.pol file in the D:\Analyst Data\Projects\API Instrument\LC Devices\CTC PAL folder and copy it to a USB flash drive.

2. On the new computer, copy the .pol file from the USB flash drive to D:\Analyst Data\Projects\API Instrument\LC Devices\CTC PAL folder.

3. In the Analyst® software profile, make sure that the hardware profile specifies the correct COM port for the autosampler. Refer to step 7 in Create a Hardware Profile on page 22.

**Issues with Gain and Integral Settings for the Pump**

Incorrect integral or gain settings might cause flow instability or gas venting when the pumps are on. Follow the instructions below to troubleshoot this issue.

1. On the new computer, in the Eksigent control software, select **System > Hardware Diagnostics** and then click the **Calibration Values** tab.

2. Write down the **gain** and **int** values found in the **Control Parameters (Field Service)** section near the bottom of the tab.

3. Repeat the preceding steps on the old computer and then compare the values for the two computers.

   The first two digits in each value should be the same. If they are not, contact SCIEX Technical Support.
This section describes how to move the SCIEX M3 MicroLC system from one location to another. It assumes that the new location includes a mass spectrometer and that the system is on a wheeled cart. Complete disassembly of the system is not required.

Instructions for transferring system settings to a different acquisition computer are also given, as well as instructions for storing the system.

### Disconnect the System at the Original Location

1. Close the Eksigent control software and mass spectrometer software, if open.
2. Using the switch on the rear of the system, turn off the power to the system and then unplug the mains supply cable.
3. Turn off the gas supply.
4. Disconnect the system from the gas.
   - For the M3 MicroLC system: Push in the red plastic ring while pulling out the tubing to remove the gas tubing from the back of the pump.
   - For the M3 MicroLC-TE system: Disconnect the gas supply at the Tee. The system is still pressurized, so it may be difficult to remove the tubing.
5. Disconnect the USB cable between the LC system and the acquisition computer.
6. Disconnect the MS interface cable between the LC system and the mass spectrometer.
7. Disconnect the tubing from the column at the ion source.

### Install the System at the New Location

**WARNING! Lifting Hazard.** Make sure that at least four people are available to lift the LC system. Follow established safe lifting procedures.

1. Carefully move the system to the new location.
2. Connect the USB cable to the port labeled **USB** on the rear of the LC system and to the acquisition computer.
3. Connect the MS interface cable to the port labeled I/O G1 on the rear of the LC system and to the mass spectrometer.

4. Connect the gas tubing to the pump.
   - For the M3 MicroLC system: Push the tubing straight into the fitting on the back of the pump.
   - For the M3 MicroLC-TE system: Connect the gas supply to the Tee.

5. Connect the gas tubing to a source of gas (clean, dry, compressed air or nitrogen, regulated to 100 psi).

6. Connect the column outlet tubing to the ion source.

7. Connect the system to the AC mains supply.

8. Reconnect the mains supply cable and, using the switch on the rear of the system, turn on the power.

9. If the acquisition computer was not moved, transfer the settings from the old computer to the new one. Refer to Transfer System Settings to Another Computer on page 115.

### Transfer System Settings to Another Computer

To use the M3 MicroLC system with a different acquisition computer, install the Eksigent control software on the new computer, transfer important files from the existing computer, and then configure the software on the new computer.

<table>
<thead>
<tr>
<th>Required Materials</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Eksigent control software CD</td>
</tr>
<tr>
<td>• USB flash drive</td>
</tr>
</tbody>
</table>

**Note:** Use the procedure below when to use the same version of the Eksigent control software on the new acquisition computer. To update the Eksigent control software as part of the move to a new computer, follow the instructions provided with the software update.

1. Back up the autosampler positions to the USB flash drive. Refer to Back Up the SSS Settings File on page 118.

2. Export the system settings .reg file from the current computer and copy them to the USB flash drive.
   a. Start the Eksigent control software.
b. Click **System > Instrument Configuration**.

![Instrument Configuration Dialog—System Tab](image)

**Figure 10-1 Instrument Configuration Dialog—System Tab**

c. Click **Export Settings** in the lower left corner. The instrument settings are exported and a dialog box opens, showing the location of the backup file.

d. Write down the location to for use in the following step and then click **OK**.

e. In Windows Explorer, navigate to the location of the Eksettings.reg file and copy it to the USB flash drive.

3. In Window Explorer, copy the settings folder from the current computer to the USB flash drive.

   a. Navigate to the installation directory.
      - For 32-bit operating systems—C:\Program Files\EksigentNanoLC
      - For 64-bit operating systems—C:\Program Files (x86)\EksigentNanoLC

   b. Copy the settings folder to the USB flash drive.

4. Install the Eksigent control software on the new computer.

   a. Using the switch on the front of the system, turn off the M3 MicroLC system.
   b. Insert the Eksigent control software CD in the CD drive and follow the instructions.

5. Copy the **settings** folder to the new computer.

   a. Insert the USB flash drive into a USB port on the new computer.
b. Copy the settings folder from the USB flash drive to the Eksigent NanoLC folder.
   • For 32-bit operating systems—C:\Program Files\EksigentNanoLC
   • For 64-bit operating systems—C:\Program Files (x86)\EksigentNanoLC

6. Install the driver for the Analyst® software and then load the settings from the EKSettings.reg file.
   a. From the Start menu, select Eksigent > Driver Configuration. If the User Account Control dialog appears, click Yes to continue.

   ![Eksigent Driver Configuration Utility](image)

   b. In the Analyst section, select Eksigent System Driver and then click Yes.

   **Note:** If the Analyst section is unavailable, this means the Analyst® software is not installed. Install it, and repeat this step.

c. To load the settings, click Calibration Disk and navigate to the EKSettings.reg file on the USB flash drive.

d. Click Apply and then Exit.

7. Before using the system, Re-initialize the Pressure Transducers on page 67.
Back Up the SSS Settings File

The SSS file contains the positions of the autosampler components.

**Required Materials**

- USB flash drive

1. Open the PAL Loader software.

2. Click **Setup**, select the COM port and then click **OK**. If the COM port is not known, select any port.

3. In the PAL Loader window, click **Info**.

   The Target dialog opens and shows information about the connection. Click **Close**. If the COM port is not correct, repeat step 2 until communication has been verified.

4. When communication has been verified, click **Backup**.

   A window appears showing a name and the location where the backup file will be saved. Change the name or location as needed.

5. Click **OK** to back up the data from the autosampler.

6. When the backup is complete, click **Start PAL** to release the keypad terminal from PAL Loader software control.

7. Click **Exit** to close the PAL Loader software.

8. In Windows Explorer, copy the backup file to a USB flash drive.
Install the SSS Settings File

Required Materials

- USB flash drive containing settings backup

1. Open the PAL Loader software.

   **Figure 10-4 PAL Loader Software**

2. Click **Update**, then click **Browse** to select the file on the USB flash drive.

   **Figure 10-5 Update Flash Memory Dialog**

3. Click **Start Update** to upload the SSS file to the autosampler.

   Wait for the SSS file to be uploaded. This may take several minutes.

4. Click **Start PAL** to release the keypad terminal from PAL Loader Software control.
5. Click **Exit** to close the PAL Loader software.

### Prepare the System for Storage

1. Change the mobile phases in the solvent bottles to isopropanol (IPA).

    **Note:** Removing the aqueous mobile phases is required to reduce the possibility of bacterial growth.

2. Purge and flush the system. Refer to Purge the Mobile Phases and Flush the System on page 68.

3. Plug all pump inlets and outlets.

4. Label the system for storage to make sure that the next user is aware that the system contains IPA.
The M3 MicroLC system is an ultra high-pressure liquid chromatography (UHPLC) system optimized for ultra-fast LC/MS analysis using 0.3 mm to 1.0 mm inner diameter (i.d.) columns. The system incorporates microfluidic flow control (MFC) to generate precise LC gradients at microflow rates. The system also includes the PAL HTC-xt autosampler with dynamic load and wash (DLW) system designed to minimize sample carryover.

**Microfluidic Flow Control**

Microfluidic flow control (MFC) has two primary benefits:

- precise gradients at microliter-per-minute rates without flow splitting
- extremely rapid response to setpoint changes enabling fast gradients and dynamic flow control

The components of a binary gradient MFC system are shown schematically in Figure A-1.

**Figure A-1 Microfluidic Flow Control (MFC) System Components**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Electronically controlled pressure source</td>
<td>4</td>
<td>Mixing Tee</td>
</tr>
<tr>
<td>2</td>
<td>Proportional-integral-derivative (PID) controller</td>
<td>5</td>
<td>Column</td>
</tr>
<tr>
<td>3</td>
<td>Flowmeter</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
How the MFC System Works

For each mobile phase:

1. The flowmeter continuously monitors the flow rate and sends a signal to the PID controller. A PID controller is a control loop feedback device that automatically adjusts one variable in a system in an attempt to hold another variable at a specified setpoint.
   For the M3 MicroLC system, the controller adjusts the pressure in order to maintain the specified flow rate.
2. The PID controller sends a voltage signal to the pressure source. The signal is proportional to the pressure required for the desired flow rate during the gradient.
3. The pressure source changes the pressure to generate the required flow rate. Pressure in the system is generated by connecting laboratory air or nitrogen to a pneumatic amplifier. For example, 100 psi incoming air pressure from the laboratory air system can be used to produce hydraulic pressure ranging from 0 psi to >10 000 psi.

Guidelines for Micro UHPLC Methods

The smaller columns used in micro ultra-high performance liquid chromatography (UHPLC) require lower flow rates, smaller injection volumes, and different electrodes and tubing than traditional UHPLC.

Flow Rate

When converting a method from traditional UHPLC to micro UHPLC, flow velocity should be kept the same so that retention times do not change.

Flow velocity, FV, is given by FV = Q × A, where:
Q = flow rate
A = cross-sectional area of the column

Table A-1 demonstrates how flow rate varies by column diameter for (approximately) the same flow velocity.

For other column diameters or other flow rates, a general guideline is that flow rate scales with the square of the column diameter. This is derived in detail in Determining Flow Rate for Different Columns on page 123.

Table A-1 Equivalent Flow Rates for Micro UHPLC

<table>
<thead>
<tr>
<th>Column Diameter (mm)</th>
<th>Flow Rate (µL/min)</th>
<th>Cross-sectional Area (mm²)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Traditional UHPLC</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4.6</td>
<td>2100</td>
<td>16.62</td>
</tr>
<tr>
<td>2.1</td>
<td>450</td>
<td>3.46</td>
</tr>
</tbody>
</table>
Table A-1 Equivalent Flow Rates for Micro UHPLC (continued)

<table>
<thead>
<tr>
<th>Column Diameter (mm)</th>
<th>Flow Rate (µL/min)</th>
<th>Cross-sectional Area (mm²)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Micro UHPLC</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.0</td>
<td>100</td>
<td>0.785</td>
</tr>
<tr>
<td>0.5</td>
<td>25</td>
<td>0.196</td>
</tr>
<tr>
<td>0.3</td>
<td>10</td>
<td>0.071</td>
</tr>
</tbody>
</table>

Determining Flow Rate for Different Columns

Consider converting a traditional UHPLC method to one for the M3 MicroLC system. Column a is used for traditional UHPLC, with a known flow rate \( Q_a \). Column b will be used on the M3 MicroLC system. What is the flow rate for column b?

Because the columns should have the same flow velocity, the relationship shown in Figure A-2 is true.

Figure A-2 Columns a and b with the Same Flow Velocity

\[
FV = \frac{Q_a}{A_a} = \frac{Q_b}{A_b}
\]

Solving for the flow rate for column b \( Q_b \) results in Figure A-3.

Figure A-3 Flow Rate for Column b

\[
Q_b = \frac{Q_a}{A_a} \times A_b
\]

Because columns are usually specified by internal diameter (i.d.), it is more useful to express the cross-sectional area in terms of the column diameter, shown in Figure A-4, where \( D \) is the column diameter.

Figure A-4 Column Cross-sectional Area in Terms of Diameter

\[
A = \pi \times \left[ \frac{D}{2} \right]^2
\]

Substituting the formula for cross-sectional area into the equation for \( Q_b \) gives Figure A-5.
Figure A-5 Flow Rate for Column b, Showing Cross-sectional Area Explicitly

\[ Q_b = \frac{Q_a}{\left( \pi \times \frac{D_b^2}{4} \right)} \times \left( \pi \times \frac{D_b^2}{4} \right) \]

\( Q_b \) can be simplified to Figure A-11. As can be seen below, the flow rate for column b is proportional to the square of the column diameter.

Figure A-6 Flow Rate for Column b, Showing Relationship to Column Diameter

\[ Q_b = Q_a \times \frac{D_b^2}{D_a^2} \]
Electrodes and Tubing

When selecting an electrode for use with the M3 MicroLC system, it is important to balance peak spreading with back pressure on the system. In general, the smaller the electrode, the narrower the peak width (Figure A-7).

Figure A-7 Mass Spectrometer Peak Width for Different Ion Source Electrodes

However, as flow rate increases so does the back pressure on the system. For example, at the relatively low flow rate of 20 µL/min, back pressure on a 25 µm diameter electrode can reach 1000 psi (Figure A-8). Also in Figure A-8, dashed lines indicate appropriate flow rate ranges for 25 µm i.d. (red) and 50 µm i.d. (brown) electrodes. The green line shows pressure for a 100 µm i.d. diameter electrode for reference.
Figure A-8 Back Pressure Versus Flow Rate for Different Ion Source Electrodes

Use Table A-2 to select the appropriate electrode and tubing based on the column diameter. Information for traditional UHPLC is given for reference.

### Table A-2 Tubing, Flow Rates, and Electrodes for Micro UHPLC

<table>
<thead>
<tr>
<th>Column Diameter (mm)</th>
<th>Flow Rate (µL/min)</th>
<th>Tubing Diameter (µm)</th>
<th>Recommended Electrode</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Pre-column</td>
<td>Post-column</td>
</tr>
<tr>
<td><strong>Traditional UHPLC</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2.1</td>
<td>200 to 1000</td>
<td>~125 (0.005 inch)</td>
<td>Standard Turbo V™ electrode (100 µm i.d.)</td>
</tr>
<tr>
<td><strong>Micro UHPLC</strong></td>
<td>4 to 20</td>
<td>50</td>
<td>25</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>25 µm or 50 µm i.d. hybrid PEEKsil/stainless steel</td>
</tr>
</tbody>
</table>
Table A-2 Tubing, Flow Rates, and Electrodes for Micro UHPLC (continued)

<table>
<thead>
<tr>
<th>Column Diameter (mm)</th>
<th>Flow Rate (µL/min)</th>
<th>Tubing Diameter (µm)</th>
<th>Recommended Electrode</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Pre-column</td>
<td>Post-column</td>
</tr>
<tr>
<td>0.5</td>
<td>10 to 50</td>
<td>50</td>
<td>25 or 50</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>50 µm i.d. hybrid PEEKsil/stainless steel</td>
</tr>
<tr>
<td>1.0</td>
<td>50 to 200</td>
<td>50</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>65 µm i.d. stainless steel or 50 µm i.d.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>hybrid PEEKsil/stainless steel</td>
</tr>
</tbody>
</table>

**Dynamic Load and Wash**

The dynamic load and wash (DLW) system on the PAL HTC-xt autosampler is designed to minimize sample carryover. Figure A-9 shows the DLW system schematically, with sample indicated in red, wash solvent 1 indicated in blue, and wash solvent 2 indicated in green.

Unlike in conventional autosamplers, the sample is never in contact with the syringe. Instead, the sample only comes into contact with the needle and the holding loop. When the sample is aspirated, it is bracketed on one or both ends with a small volume of air that creates a barrier to prevent the diffusion of the sample into the wash solvent. The air also assists in cleaning the entire injection path. At the end of the injection cycle, all parts of the system which have been in contact with the sample are washed with both organic and aqueous wash solvents and are completely clean, resulting in near-zero carryover for most components.
### Theory of Operation

#### Figure A-9 Schematic Drawing of the DLW System

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Syringe</td>
<td>10</td>
<td>From pump</td>
</tr>
<tr>
<td>2</td>
<td>Solenoid/actuator valve</td>
<td>11</td>
<td>To column</td>
</tr>
<tr>
<td>3</td>
<td>Holding loop</td>
<td>12</td>
<td>Sample—specified by Injection Volume</td>
</tr>
<tr>
<td>4</td>
<td>Wash station</td>
<td>13</td>
<td>Rear sample—specified by Rear Volume</td>
</tr>
<tr>
<td>5</td>
<td>Wash solvent 2 waste</td>
<td>14</td>
<td>Rear airgap—specified by Rear Airgap Volume</td>
</tr>
<tr>
<td>6</td>
<td>Wash solvent 1 waste</td>
<td>15</td>
<td>DLW pump 2</td>
</tr>
<tr>
<td>7</td>
<td>To waste container</td>
<td>16</td>
<td>Wash solvent 2 (aqueous)</td>
</tr>
<tr>
<td>8</td>
<td>Front airgap—specified by Front Airgap Volume</td>
<td>17</td>
<td>Wash solvent 1 (organic)</td>
</tr>
<tr>
<td>9</td>
<td>Front sample—specified by Front Volume</td>
<td>18</td>
<td>DLW pump 1</td>
</tr>
</tbody>
</table>
The DLW Process

Figure A-10 Holding Loop and Syringe, Showing Location of Sample and Airgaps

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Holding loop</td>
<td>4</td>
<td>Injection Volume (sample)</td>
</tr>
<tr>
<td>2</td>
<td>Rear Airgap Volume (air)</td>
<td>5</td>
<td>Front Volume (sample)</td>
</tr>
<tr>
<td>3</td>
<td>Rear Volume (sample)</td>
<td>6</td>
<td>Front Airgap Volume (air)</td>
</tr>
</tbody>
</table>

Bold text in Figure A-10 indicates user-settable volumes.

**Note:** The Rear Airgap Volume (µL) field requires a value of at least 0.01.

1. Air and sample are aspirated in the needle and holding loop (item 1 in Figure A-10).
2. The needle and holding loop and their contents are moved to the injection port.
3. The front airgap and front sample (items 5 and 6) are dispensed immediately.
4. When the M3 MicroLC system is ready to start a run, the sample is dispensed and the valve is switched to inject the sample onto the column.
5. After the valve is switched, the entire sample path, including the valve and needle, is washed. Typically the path is washed first with the organic wash solvent and then with the aqueous wash solvent.

**About Partial- and Full-loop Injections**

Depending on the sample loop that is installed on the system and the volume of sample available, the sample loop can either be partially or completely filled.

In the M3 MicroLC system, the default position of the sample loop on the injection valve at the start of a new method is in the load position. It is important that the loop is full of a solvent that will allow your sample to be retained on your trap or column (typically this is the starting composition of your LC method), particularly for a partial-loop injection where the front volume is 0. In the example experiments described previously, the final steps of the Gradient 1 LC method return the sample loop to the initial conditions (refer to Figure 5-4 on page 46 and Figure 6-4 on page 56).

**Partial-loop Injections**

For a partial-loop injection, the autosampler method specifies that the autosampler will pick up a rear airgap (air), a rear volume (sample), and the specified volume of sample (Figure A-11). The rear airgap isolates the sample from the transfer liquid of the autosampler and the rear volume prevents the airgap from entering the sample loop. (Airgap volumes are typically between 1 µL to 3 µL and the rear volume is typically 1 µL of sample.) The sample volume is the amount of sample to be injected in the experiment and is less than the volume of the sample loop.

**Figure A-11 Schematic Drawing of Partial-Loop Injection**
After the autosampler needle is seated in the injection port, only the sample volume is dispensed into the valve and into the sample loop (partially filling the sample loop).

**Full-loop Injections**

In a full-loop injection, the autosampler method specifies a rear airgap, a rear volume, the sample volume, a front volume and a front airgap (Figure A-12). The front volume and front airgap help to limit the sample mixing with the liquid originally in the loop and the rear airgap and rear volume act as in a partial-loop injection.

![Figure A-12 Schematic Drawing of Full-Loop Injection](image)

After the autosampler needle is seated in the injection port, a volume equal to the front airgap, the front volume, and the sample volume is dispensed into the valve and through the sample loop, with the front airgap and the front volume exiting out of the waste side of the sample loop.

For either type of injection, parameters in the autosampler method define the volumes and the airgaps. Refer to Parameters for the Autosampler Method on page 134 and Volumes in the Autosampler Method on page 135 for more information.
Theory of Operation

Injection Modes

For both partial-loop and full-loop injections, there are four modes of sample injection. They differ in whether the sample loop stays in-line during the acquisition and how much of the contents of the sample loop is transferred to the column. The injection mode is selected in the Run Conditions tab in LC Method Settings dialog, shown in Figure A-13.

Figure A-13 LC Method Settings Dialog—Sample Injection Section

- **None**—the sample valve does not switch during the acquisition.
- **Standard**—the sample valve switches to the inject position when acquisition begins and returns to the load position when acquisition ends. The sample loop remains in the flow path during acquisition.
- **Metered**—the valve switches to the inject position when acquisition starts, and then the specified volume of sample is delivered to the column by the LC pumps at the specified flow rate. After the specified volume is injected, the sample valve switches to the load position, removing the sample loop from the flow path.

Use metered injection when the sample loop volume is larger than the volume to be injected on the column. With metered injection, the large sample loop doesn’t add extra dead-volume, preventing extra-column broadening.

The minimum injection volume (in nanoliters) is given by $2.5 \times Q$, where $Q$ is the flow rate. To inject a smaller volume, decrease the flow rate in the LC method.

- **Rapid**—the valve operates as for a metered injection, except the LC pumps increase the flow rate during the injection in order to inject the sample quickly and prevent extra-column broadening.

About the Autosampler Method

The Analyst® software uses the autosampler method to communicate with the autosampler and the DLW system. The autosampler method is part of the acquisition method.

The appropriate method for the autosampler depends on the type of experiment to be performed:

- For a direct injection experiment: M3 MicroLC Direct Inject revA
- For a trap-and-elute experiment: M3 MicroLC Trap Elute revA

By default, both of these methods are for partial-loop injections. Table A-3 on page 134 indicates the necessary changes for a full-loop injection.
Steps in the Autosampler Method

The autosampler method consists of the steps below.

1. Lock the keypad terminal.
2. Wait for a signal from the mass spectrometer.
3. Aspirate the sample, then:
   a. Dip the needle in organic wash solvent 1.
   b. Dip the needle in aqueous wash solvent 2.
4. Move the needle to the injection port on the valve.
5. Load the sample on the injection loop, then switch the valve to inject the sample onto the column.
6. Wash the system:
   a. Wash the injection valve and needle with the specified wash solvent, typically the organic wash solvent.
   b. Wash the injection valve and needle with the specified wash solvent, either with the aqueous wash solvent
      or a second wash with the organic wash solvent.

7. Optionally, wash the injection valve and needle again with the specified wash solvent (typically the aqueous
   wash solvent).

   **Note:** If the first two wash steps use the organic wash solvent, a final aqueous wash step is recommended.
   (Wash solvents are selected in the Cycle Arguments table, where "Wash 1" is organic and "Wash 2" is aqueous.)

8. Move the needle to the home position.

9. Unlock the keypad terminal.

### Parameters for the Autosampler Method

Parameters for the autosampler method are set in the Cycle Arguments table of the Acquisition Method window. Recommended values for the parameters and their ranges are listed in **Table A-3**.

**Note:** Use the default values in the methods except for those indicated with "***" in **Table A-3**.

### Table A-3 Parameters in the Cycle Arguments Table

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Recommended Values</th>
<th>Range</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Partial-Loop</td>
<td>Full-Loop Injection</td>
</tr>
<tr>
<td>Rear Airgap Volume (µL)</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>Rear Volume (µL)</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>Front Volume (µL)</td>
<td>0</td>
<td>1*</td>
</tr>
<tr>
<td>Front Airgap Volume (µL)</td>
<td>0</td>
<td>1*</td>
</tr>
<tr>
<td>Sample Aspirate Speed (µL/s)</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>Pullup Delay (ms)</td>
<td>500</td>
<td>500</td>
</tr>
<tr>
<td>Num of Wash1 PreDips</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>Num of Wash2 PreDips</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Inject to</td>
<td>LCVlv1</td>
<td>LCVlv1</td>
</tr>
</tbody>
</table>
Table A-3 Parameters in the Cycle Arguments Table (continued)

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Recommended Values</th>
<th>Range</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Partial-Loop Injection</td>
<td>Full-Loop Injection</td>
</tr>
<tr>
<td>Injection Speed (µL/s)</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>Needle Gap for 2nd and Final Vlv Clean (mm)</td>
<td>0*</td>
<td>0*</td>
</tr>
<tr>
<td>First Wash Solvent</td>
<td>Wash1</td>
<td>Wash1</td>
</tr>
<tr>
<td>Valve Clean Time 1 (s)</td>
<td>5</td>
<td>5</td>
</tr>
<tr>
<td>Needle Clean Time 1 (s)</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>Second Wash Solvent</td>
<td>Wash1</td>
<td>Wash1</td>
</tr>
<tr>
<td>Needle Clean Time 2 (s)</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>Valve Clean Time 2 (s)</td>
<td>5</td>
<td>5</td>
</tr>
<tr>
<td>Replicate Count</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>Final Wash Solvent</td>
<td>Wash2*</td>
<td>Wash2*</td>
</tr>
<tr>
<td>0 or 1 Final Cleans</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>Final Needle Clean Time (s)</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>Final Valve Clean Time (s)</td>
<td>5</td>
<td>5</td>
</tr>
</tbody>
</table>

Note: Values prefixed with "SYR" can be changed using the autosampler keypad terminal, but the default values should be appropriate for the majority of situations.

### Volumes in the Autosampler Method

The autosampler method contains parameters related to the volume of the sample loop, the syringe, and the sample. These are shown in Figure A-15.

#### Figure A-15 CTC Autosampler Basic Properties Tab—Detail

![Figure A-15](CTC PAL Autosampler Basic Properties)

1. Loop Volume 1 (µL): 100
2. Actual Syringe (µL): 100
3. Injection Volume (µL): 10,000
**Theory of Operation**

<table>
<thead>
<tr>
<th>Item</th>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Loop Volume</td>
<td>Indicates the volume of the sample loop installed on the injection valve. This is entered during installation. These volumes are not used in the method.</td>
</tr>
<tr>
<td>2</td>
<td>Actual Syringe</td>
<td>Indicates the volume of the syringe installed in the autosampler. The Injection Volume (item 3) cannot be greater than the Actual Syringe volume.</td>
</tr>
<tr>
<td>3</td>
<td>Injection Volume</td>
<td>Specifies the volume aspirated by the autosampler needle for loading in the loop. This is the volume shown in the Inj. Volume cell in the Analyst® software Batch Editor window. This volume does not include the Front Volume or Rear Volume.</td>
</tr>
</tbody>
</table>

**Recommendations for the Injection Volume**

For a partial-loop injection, type a value up to 50% of the sample loop volume.

For a full-loop injection, type a value 1.5 to 5 × the sample loop volume.

**Note:** If the Inj. Volume cell in the Analyst® software Batch Editor window is edited after the acquisition method is selected, the new value takes precedence and is aspirated by the autosampler.
## System Specifications

### System

| Dimensions (L × W × D) | 85 cm × 58 cm × 70 cm (33.5 inches × 22.8 inches × 27.6 inches)  
Add 14 cm (5.6 inches) to width for the bottle rack. |
|------------------------|-----------------------------------------------------------------------------------------------------|
| Weight                 | - M3 MicroLC system: 50 kg (110 pounds)  
- M3 MicroLC-TE system: 64 kg (140 pounds) |
| Electrical             | - Input line voltage: 100 V to 240 V AC  
- Input line frequency: 50Hz or 60 Hz  
- Input current: 2.5 A |
| Instrument control     | Eksigent control software with driver for the Analyst® software |
| I/O                    | - Communication: USB 2.0 (or greater)  
- TTL: Run in  
- Contact closure: Ready out/run out/Valve out/2 programmable auxiliary |
| Working environment    | - Altitude: ≤1828 m (6000 feet) above sea level  
- Humidity: 20% to 80%, non-condensing  
- Temperature: 15 °C to 30 °C (59 °F to 86 °F) |

### Pump

| Flow rate range        | Analytical gradient: 5 μL/min to 50 μL/min or 20 μL/min to 200 μL/min  
(M3 MicroLC-TE only) Loading gradient: 20 μL/min to 200 μL/min |
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Gradient delay volume</td>
<td>&lt;3 μL</td>
</tr>
<tr>
<td>Maximum pressure</td>
<td>10 000 psi</td>
</tr>
<tr>
<td>Retention time reproducibility</td>
<td>&lt;0.5% RSD at 20 μL/min for the 5 μL/min to 50 μL/min configuration</td>
</tr>
<tr>
<td>Wetted parts</td>
<td>Stainless steel, PEEK, fused silica, titanium, FEP, Teflon, and ceramic</td>
</tr>
</tbody>
</table>
## System Specifications

### Autosampler

| Injection reproducibility | • Full loop: <1% RSD  
<table>
<thead>
<tr>
<th></th>
<th>• Partial loop: &lt;2% RSD</th>
</tr>
</thead>
</table>
| Injection valves          | • 6 ports              
|                          | • 1/32 inch connections 
|                          | • Port-to-port volume <60 nL 
|                          | • Maximum pressure: 10 000 psi 
|                          | • 316 stainless steel with proprietary coating |
| Injection volume          | 2 µL to 50 µL |
| Sample carryover          | <0.005% (benzophenone) |
| Sample capacity           | • 6 positions for trays or microtiter plates 
|                          | • 54 2 mL vials per tray 
|                          | • Microtiter plates:  
|                          | • Standard depth 96-well 
|                          | • Deep 96-well 
|                          | • 384-well |
| Sample cooling temperature| Minimum 4 °C (room temperature ~20 °C) |
| Syringe volume            | 100 µL |
| Wetted parts              | Stainless steel, PEEK, FEP, glass |

### Oven

| Temperature range and accuracy | Ambient +5 °C to 60 °C |
| Outer dimensions (L × W × D)   | 25 cm × 4 cm × 4 cm (10 inches × 1.5 inches × 1.5 inches) |
| Inside dimensions (L × W × D)  | 20 cm × 1.9 cm × 1.6 cm (8 inches × 3/4 inches × 5/8 inches) |
Order Parts

Order parts from SCIEX in any of the following ways:

- **Telephone:** (877) 740-2129, Option 1 (toll-free, United States only), or go to sciex.com/contact-us to find a local office.
- **E-mail:** Sales.Americas@sciex.com
- **Fax:** (800) 343-1346

Consumables and Accessories

<table>
<thead>
<tr>
<th>Part Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>801-00075</td>
<td>Bottle, 1 L with drilled cap</td>
</tr>
<tr>
<td>801-00067</td>
<td>Bottle, 250 mL with drilled cap</td>
</tr>
<tr>
<td>5018262</td>
<td>Calibration kit</td>
</tr>
<tr>
<td>5041604</td>
<td>Column oven mounting kit</td>
</tr>
<tr>
<td>5039577</td>
<td>Column, HALO Peptide-ES, 500 µm i.d., 2.7 µm × 5 cm</td>
</tr>
<tr>
<td>5028467</td>
<td>Electrode, 25 µm i.d.</td>
</tr>
<tr>
<td>5029342</td>
<td>Electrode, 65 µm i.d.</td>
</tr>
<tr>
<td>5016941</td>
<td>Electrode-to-source grounding kit</td>
</tr>
<tr>
<td>910-00091</td>
<td>Ferrule, 1/8 inch, super flangeless (10-pack)</td>
</tr>
<tr>
<td>5019820</td>
<td>Ferrule, 1/32 inch to 1/16 inch 10-32 port (5-pack)</td>
</tr>
<tr>
<td>910-00087</td>
<td>Ferrule, stainless steel 1/32 inch (10-pack)</td>
</tr>
<tr>
<td>5019301</td>
<td>Fitting, drain collar</td>
</tr>
</tbody>
</table>
### Table C-1 Consumables and Accessories—Sorted by Description (continued)

<table>
<thead>
<tr>
<th>Part Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>5019821</td>
<td>Fitting, 1/32 inch to 1/16 inch 10-32 port (5-pack)</td>
</tr>
<tr>
<td>200-00342</td>
<td>Fitting, column 6-32 threading</td>
</tr>
<tr>
<td>200-00252</td>
<td>Fitting, flangeless tube end 1/16 inch ferrule</td>
</tr>
<tr>
<td>200-00418</td>
<td>Fitting, headless PEEK, 1/32 inch o.d.</td>
</tr>
<tr>
<td>5016413</td>
<td>Fitting, union straight hex 6-32 F × 6-32 F</td>
</tr>
<tr>
<td>200-00388</td>
<td>In-line filter assembly (includes 5 filter capsules)</td>
</tr>
<tr>
<td>5041276</td>
<td>M3 MicroLC system tubing kit</td>
</tr>
<tr>
<td>200-00329</td>
<td>Mobile phase filter with 10 µm frit</td>
</tr>
<tr>
<td>910-00085</td>
<td>Nut, 1/32 inch o.d., 0.45 inches long (10-pack)</td>
</tr>
<tr>
<td>910-00090</td>
<td>Nut, 1/8 inch super flangeless (10-pack)</td>
</tr>
<tr>
<td>5024174</td>
<td>Nut, gold-colored, 6-32 thread 3/16 (1 nut)</td>
</tr>
<tr>
<td>200-00396</td>
<td>Pipette, 100 µL for calibration</td>
</tr>
<tr>
<td>200-00383</td>
<td>Pipette, 200 µL for calibration</td>
</tr>
<tr>
<td>620-00071</td>
<td>Plate, 54-vial, blue for autosampler</td>
</tr>
<tr>
<td>5017799</td>
<td>Sample loop, 5 µL PEEKsil (no fittings are included)</td>
</tr>
<tr>
<td>5040770</td>
<td>Sample loop, 50 µL stainless steel</td>
</tr>
<tr>
<td>4460861</td>
<td>Sample syringe</td>
</tr>
<tr>
<td>5023797</td>
<td>Syringe needle guide</td>
</tr>
<tr>
<td>5031383</td>
<td>Syringe needle kit, with hubs and nuts for autosampler DLW system (3-pack)</td>
</tr>
<tr>
<td>4460827</td>
<td>Syringe, replacement plungers (10-pack)</td>
</tr>
<tr>
<td>5027467</td>
<td>Trap column cartridge holder</td>
</tr>
<tr>
<td>5028897</td>
<td>Trap column cartridge, ChromXP C18 (5-pack)</td>
</tr>
<tr>
<td>5042103</td>
<td>Trap column mounting assembly</td>
</tr>
<tr>
<td>5042106</td>
<td>Tray, for solvent bottles on instrument</td>
</tr>
<tr>
<td>205-00089</td>
<td>Tubing, PEEKsil, 25 µm i.d., 1/32 inch o.d., 5 cm</td>
</tr>
<tr>
<td>205-00091</td>
<td>Tubing, PEEKsil, 25 µm i.d., 1/32 inch o.d., 10 cm</td>
</tr>
</tbody>
</table>
Table C-1 Consumables and Accessories—Sorted by Description (continued)

<table>
<thead>
<tr>
<th>Part Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>205-00038</td>
<td>Tubing, PEEKsil, 50 µm i.d., 1/32 inch o.d., 15 cm</td>
</tr>
<tr>
<td>205-00039</td>
<td>Tubing, PEEKsil, 50 µm i.d., 1/32 inch o.d., 20 cm</td>
</tr>
<tr>
<td>205-00070</td>
<td>Tubing, PEEKsil, 50 µm i.d., 1/32 inch o.d., 5 cm</td>
</tr>
<tr>
<td>205-00041</td>
<td>Tubing, PEEKsil, 50 µm i.d., 1/32 inch o.d., 50 cm</td>
</tr>
<tr>
<td>205-00049</td>
<td>Tubing, PEEKsil, 50 µm i.d., 1/32 inch o.d., 75 cm</td>
</tr>
<tr>
<td>205-00069</td>
<td>Tubing, PEEKsil, 50 µm i.d., 1/32 inch o.d., 10 cm</td>
</tr>
<tr>
<td>205-00061</td>
<td>Tubing, PEEKsil, 75 µm i.d., 1/32 inch o.d., 30 cm</td>
</tr>
<tr>
<td>205-00058</td>
<td>Tubing, PEEKsil, 75 µm i.d., 50 cm</td>
</tr>
<tr>
<td>5019620</td>
<td>Tubing, mobile phase, 5 ft</td>
</tr>
<tr>
<td>5016413</td>
<td>Union, stainless steel, zero dead volume with 1/32 inch o.d. ports</td>
</tr>
<tr>
<td>200-00413</td>
<td>Union, stainless steel, 1/32 inch o.d. ports, 0.50 mm</td>
</tr>
<tr>
<td>200-00452</td>
<td>Valve pod and fittings</td>
</tr>
<tr>
<td>200-00326</td>
<td>Valve rotor seal</td>
</tr>
<tr>
<td>910-00103</td>
<td>Vial caps, snap caps with split septa (100-pack)</td>
</tr>
<tr>
<td>800-00209</td>
<td>Vials, 2 mL (100-pack)</td>
</tr>
<tr>
<td>100-00567</td>
<td>Wrench, for 1/32 inch and 1/16 inch nuts</td>
</tr>
</tbody>
</table>
This section shows the external interface to other components. The external interface connections synchronize sample injection with data collection. The connector pin assignments are also described.

Table D-1 Pin Assignments for DB-25 Connector

<table>
<thead>
<tr>
<th>Pin Number</th>
<th>Function</th>
<th>Pin Number Mate</th>
</tr>
</thead>
<tbody>
<tr>
<td>Top Row (large side)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Aux out</td>
<td>14</td>
</tr>
<tr>
<td>2</td>
<td>Divert valve trigger</td>
<td>15</td>
</tr>
<tr>
<td>3</td>
<td>Not used</td>
<td>16</td>
</tr>
<tr>
<td>4</td>
<td>Not used</td>
<td>17</td>
</tr>
<tr>
<td>5</td>
<td>Valve out</td>
<td>18</td>
</tr>
<tr>
<td>6</td>
<td>Run out</td>
<td>19</td>
</tr>
<tr>
<td>7</td>
<td>TE mode</td>
<td>20</td>
</tr>
<tr>
<td>8</td>
<td>Rdy out</td>
<td>21</td>
</tr>
<tr>
<td>9</td>
<td>A/D ground</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Not used</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>A/D input</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Prk in</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>Run in</td>
<td></td>
</tr>
<tr>
<td>Bottom Row (small side)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>Aux out</td>
<td>1</td>
</tr>
<tr>
<td>15</td>
<td>Divert valve trigger</td>
<td>2</td>
</tr>
<tr>
<td>16</td>
<td>Not used</td>
<td>3</td>
</tr>
<tr>
<td>17</td>
<td>Not used</td>
<td>4</td>
</tr>
<tr>
<td>18</td>
<td>Valve out</td>
<td>5</td>
</tr>
</tbody>
</table>
Table D-1 Pin Assignments for DB-25 Connector (continued)

<table>
<thead>
<tr>
<th>Pin Number</th>
<th>Function</th>
<th>Pin Number Mate</th>
</tr>
</thead>
<tbody>
<tr>
<td>19</td>
<td>Run out</td>
<td>6</td>
</tr>
<tr>
<td>20</td>
<td>TE mode</td>
<td>7</td>
</tr>
<tr>
<td>21</td>
<td>Rdy out</td>
<td>8</td>
</tr>
<tr>
<td>22</td>
<td>Common ground</td>
<td></td>
</tr>
<tr>
<td>23</td>
<td>Common ground</td>
<td></td>
</tr>
<tr>
<td>24</td>
<td>Common ground</td>
<td></td>
</tr>
<tr>
<td>25</td>
<td>Common ground</td>
<td></td>
</tr>
</tbody>
</table>

Figure D-1 25-pin DB Connector Male Fitting

The 25-pin DB connector in Figure D-1 is a male connector viewed end on (that is, from the exposed male pin side and not from the hidden solder post side). D connectors have very small numbers inscribed on them indicating the pin numbers—a high power magnifier is often required to observe the numbers. Identify the numbers before creating or modifying connectors to the pump. When the connector cover is removed to solder new connections, the location of the pins might appear reversed. Verify the orientation before soldering. The common grounds are all tied together and can be used interchangeably.
## Revision History

<table>
<thead>
<tr>
<th>Revision</th>
<th>Reason for Change</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>First release of document.</td>
<td>October 2015</td>
</tr>
<tr>
<td>B</td>
<td>Added new warnings in Electrical Precautions, instructions about routing waste tubing, minimum values for acquisition method parameters, and information for troubleshooting TE systems. Updated autosampler method parameters and installation and configuration procedures for new injection port.</td>
<td>December 2016</td>
</tr>
</tbody>
</table>
buffer, list of 11

C

carryover 59, 105
channels, selecting 20
chemical precautions, protective equipment 10
cleaning the system 66
column oven
  dimensions 138
  pre-heating 40
  specifications 138
COM port setting
  autosampler 24
  Eksigent control software 112
compound parameters 48, 62
consumables
  ordering 139
  part numbers 139

D

Decontamination Forms and system returns 13
dimensions of system 137
direct injection
  acquisition method 47
  LC method 42
  system configuration 34
  using Gradient 2 51
  valve plumbing 28
disposal
  chemicals 11
DLW
  about 127
  actuator, verifying 80
  maintenance 80
  testing 80
Index

E
Eksigent control software
  COM port setting 112
  moving settings to a new computer 115
electrode
  acquisition method for flushing 99
  grounding 30
  guidelines for selecting 126
  installing in ion source 32
  LC method for flushing 98
environmental conditions, required 12
environmental health and safety regulations 7
external interface connections 142

F
filter, installing 33
flow rate
  appropriate electrode for 32
  available configurations 19
  guidelines for setting 122
  measuring 70
flow velocity 122
flowmeters, calibrating 71
flush gas 106
flushing
  electrode 98
  injection valve 39
  system 68
  full-loop injection 131

G
gain and integral settings 113
Gradient 2
  direct injection experiment with 51
  disabling in acquisition method 49
  LC method 57
grounding, electrode 30
guard column 97
guidelines
  electrodes 126
  flow rate 122
  sample preparation 97
  tubing 126

H
hardware profile
  creating 22
  doesn't activate 112
  verifying 21
hazard symbols 15

I
I/O specifications 137
in-line filter, installing 33
injection mode 132
injection port
  position, configuring 90
  replacing 73
injection valve
  flushing 39
  sample loop, replacing 74
injection volume
  minimum 132
  setting 135

L
LC method
  electrode flushing 98
  gradient 42
  Gradient 2 52
  trap loading 57
  loading mobile phases 35
  local regulations 11

M
maintenance
  autosampler and DLW 80
  personnel requirements 13
  pump 67
  valve 73
  maintenance schedule 65
mass spectrometer
  access to mains supply connector 9
  returning to manufacturer 13
metered injection mode 132
microfluidic flow control 121
minimum injection volume 132
mobile phase
  compatibility 38
  creating custom 38
  loading 35
  pH range 38
  purging and flushing 68
modifying the system 14
monitoring a run 50, 64
MS acquisition method 47, 61

N
needle
  penetration depth for a vial, setting 92
  penetration into valve, setting 91
  penetration range, setting 93
  replacing 83

O
ordering, parts and accessories 139
organic solvents, list of 11

P
part numbers 139
partial-loop injection 130
personal protective equipment, precautions 10
plumbing diagram
  direct injection 28
  post-column 30
  trap-and-elute 29
pod, replacing 77
post-column filter, installing 33
pressure transducers, initializing 67
pump
  maintenance 67
  selecting in software 20
pump seal rinse, replacing 68
purging the system 68

R
rapid injection mode 132
re-initializing pressure transducers 67
regulations
  local 11
  rotor seal, replacing 74

S
Safety Data Sheets 10
sample carryover 138
sample drawers
  condensation inside 106
  cooling limit 138
  temperature, setting 82
sample loop
  position of sample inside 130
  replacing 74
sample preparation guidelines 97
sample, mass limits 97
SCIEX TripleTOF Systems
  calibration method template 95
seal rinse, replacing 68
source and gas parameters 47, 61
 specifications 137
SSS settings file
  backing up 118
  updating 119
standard injection mode 132
storage instructions 120
 syringe
  barrel, replacing 85
  needle, replacing 83
  plunger, replacing 87
system
  cleaning 66
  components 19
  connections, testing 40
  dimensions 137
  disconnecting 114
  installing 114
  maintenance personnel requirements 13
  moving 114
  returning to manufacturer 13
  sample capacity 138
  specifications 137
  storing 120
Index

use and modification 14
weight 137

system configuration
  direct injection mode 34
  trap-and-elute mode 34

T

theory of operation 121
trap-and-elute
  acquisition method 61
  Gradient 1 LC method 52
  Gradient 2 LC method 57
  system configuration 34
  valve plumbing 29
tray holder position, configuring 88
tray type, setting 92
TripleTOF Systems
  calibration method template, modifying 93
troubleshooting
  autosampler 106
  column oven 105
  flow control 107
  moving to a new computer 112
  system initialization 102
  valves 103
tubing
  best practices 97
  guidelines for selecting 126

V

valve
  maintenance 73
  penetration of needle, setting 91
  pod, replacing 77
  rotor seal, replacing 74
valve plumbing
  detailed instructions 31
  direct injection 28
  trap-and-elute 29

W

wash solvents, replacing 80
wash station position, configuring 88

zeroining pressure transducers 67